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1. C/C++

1.1 Configure Development Environment

1. Open Visual Studio 2019 and create a new project.

Visual Studio 2019

Open recent Get started
Search recent (Alt+S) Al 2%, Clone a repository

Get code from an anline repository like GitHub or
Azure DevOps

b Today

b Yesterday . .

b This week "’@ Open a project or solution

b This month Open a lecal Visual Studio project or sln file

b Qlder

-, Open a local folder

Navigate and edit code within any folder

%

P

Create a new project

Choose a project template with code scaffolding
to get started

Continue without code

2. Select the Empty project, and click next.

= o X
. ‘t Search for templates [Alt+5) P~
All languages - Allplatforms - All project types -
Recent project templates
4% Empty Project -
RN - : Windows. Provides no -
1 Windows Forms App (NET Start from scratch with C++ for Windows. Provides no starting files.
1 c#
LSO Ce+  Windows  Censele
=7 Empty Project c-+ 44 Console App
h Run code in @ Windows terminal. Prints “Hello World® by default.
[ ATL Project Ces

C++ Windows Console
Eci Windows Forms App (NET Framewark)

A project for creating an application with a Windows Forms (WinForms) user
interface

c# Windows Desktop

m CMake Project

Build modern, cross-platform C++ apps that don't depend on sl or wexproj files.

C++ Windows Linux Consale

Iﬂ Windows Desktop Wizard
= Create your own Windows app using a wizard.

Nindows Desktop Cansale Librar

Back Next

3. Fillin the project name and storage location, uncheck "Place solution and project

in the same directory", and then click Create.
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5.

6.

Configure your new project

Empty Project  c++  Windows  Console

Project name

| SWP |

Location

| C:\Users\ 13335\ Desktop\SWP_Examplel '|

Solution name (7)

‘ swe |

| Place solution and project in the same directory

Once created, copy the htra_api folder from the delivery USB drive
Windows\HTRA_API\x86 to the same level directory of the project (this example
is for configuring an x86 architecture project; if you want to configure an x64

architecture project, copy the Windows\HTRA_API\x64\htra_api folder).

Users » 15335 > Desktop > SWP Example > SWP > Search SWP Q
T Sort = View B Details
=
MName Date modified Type Size
RT3 File folder
htra_api File folder
SWP File folder
ﬁg SWP.sln 12/5/2024 416 PM Visual Studic Solu.. 2KB

Double-click to open SWP.sIn, and create a new SWP.cpp file in the source files.

Click on "Project" in the menu bar and select "Properties".

HTRA API Example Usage Guide 10



uq File Edit View Git Build Debug Test Analyze Tools Extensions Window Help  Search (Ctrl-0) F SWP

dows Debugger ~ < B i = | N _

(Global Scope)
Ctrl Shift+X
Ctrl Shift+ A
Shift+Alt+A

Exclude From Project

Show Al Files

Rescan Solution

Display Browsing Database Errors
Clear Browsing Database Errors
#p| Manage Connected Services

Set as Startup Project

Export Template.

‘B ¥Manage NuGet Packages.

& SWP Properties

7. Select "Win32" for the configuration platform, and set the environment variable
in Configuration Properties -> Debug to Path=..\htra_api (when configuring for
the x64 architecture, select "x64" for the configuration platform; otherwise, steps
7-10 of the configuration process are the same as for the x86 architecture

(Win32)).

SWP Property Pages ? x
Configuration:  Debug ~ | Platform:  Win32 ~ Configuration Manager...
AI Configuration Properties I Debugger to launch:
General Local Windows Debugger ~

Advanced

Debugging

VC++ Directories

Command S(TargetPath)

Command Arguments

b C/Cer
b Linker Working Directory S(ProjectDir)

I Manifest Tool \ Attach Ne

I XML Document Generator \ Debugger Type Auto

I Browse Information Path=_\htra_api w
> Build Events Merge Environment Yes

I Custom Build Step S0L Debugging Mo

> Code Analysis Amp Default Accelerator WARP software accelerator

Environment
Specifies the environment for the debugee, or variables to merge with existing envirenment.

Cancel Apply

8. Set the Additional Include Directories in Configuration Properties -> C/C++ ->

General to S(SolutionDir)\htra_api.
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0.

SWP Property Pages

Configuration:  Debug

T X

w Platform:  Win32 ~ Configuration Manager...

4 Configuration Properties
General
Advanced
Debugging
WC++ Directories
4 C/C++
Optimization
Preprocessor
Code Generation
Language
Precompiled Heade
Output Files
Browse Information
External Includes
Advanced
All Options
Command Line
I Linker
I Manifest Tool
I XML Document Genera
I Browse Information

A nal Include Directol $(SolutionDir)\htra_api ~

Additional #using Directories
Additional BMI Directories
/ Additienal Module Dependencies

Additienal Header Unit Dependencies

Scan Sources for Module Dependencies No

Translate Includes to Imports No

Debug Infermation Format Program Database for Edit And Continue (/Z1)
Support Just My Code Debugging Yes (fIMC)

Cemmen Language RunTime Support

Consume Windows Runtime Extension

Suppress Startup Banner Yes (/nologo)

Warning Level Level3 (/W3)

Treat Warnings As Errors Mo (/WX-)

Warning Version

Diagnostics Format Celumn Info (/diagnosticsicelumn)
SDL checks Yes (fsdl)

Multi-processor Compilation

Enable Address Sanitizer Ne

Additional Include Directories

Specifies one or more directories to add to the include path. Separate with ;' if more than one.

(lpathl)

Cancel Apply

SWP Property Pages

Configuration:  Debug

Set the Additional Library Directories in Configuration Properties -> Linker ->

General to S(SolutionDir)\htra_api.

External Includes
Advanced
All Options
Command Line
4 Linker
Input
Manifest File
Debugging
System
Optimization
Embedded IDL
Windows Metadata
Advanced
All Options
Command Line
Manifest Tool
XML Document Genera
Browse Information
Build Events
Custom Build Step
Code Analysis

v v T v T v

4 *
~ | Platform:  Win32 ~ Cenfiguration Manager...
Output File S{0utDir)5(TargetName) $(TargetExt)
Show Progress Mot Set
Version
Enable Incremental Linking Yes (/INCREMENTAL)
Incremental Link Database File S{IntDir)$(TargetMamel.ilk
Suppress Startup Banner Yes (fMOLOGO)
Ignore Import Library Mo
Register Output Mo
Per-user Redirection No
Additienal Library Directories $(SolutionDir]\htra_api ~
Link Library Dependencies Yes
Use Library Dependency Inputs Mo

Link Status

Prevent DIl Binding

Treat Linker Warning As Errors
Force File Qutput

Create Hot Patchable Image
Specify Section Attributes

Additional Library Directories

Allows the user to override the envirenmental library path. (/LIBPATH:folder)

Cancel Apply

10. Add htra_api.lib to the Additional Dependencies in Configuration Properties ->

Linker -> Input.
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SWP Property Pages ? X

Configuration:  Debug ~ | Platform:  Win32 ~ Cenfiguration Manager...

External Includes

Additional Dependencies
Advanced Ignore All Default Libraries

htra_apilib;kernel32.libuser32.lib;gdi3 2 lib;winspool lib; -

All Options Ignore Spec 3 braries
Command Line Module D
Zbkey Adddviodule to Assembly
Genetal | A Embed Managed Resource File
] Force Symbol References
Manifest File Delay Loaded Dils
Debugging Assembly Link Resource
System
Optimization
Embedded IDL
Windows Metadata
Advanced
All Options
Command Line
I Manifest Tool
I XML Document Genera
I> Browse Information
> Build Events
I Customn Build Step Additional Dependencies
b Code Analysis Specifies additional items to add to the link command line. [i.e. kernel32.lib]

Cancel Apply

11. At this point, the environment configuration is complete, and programming
development can begin. You can refer to the C/C++ examples included on the
USB drive, specifically in

Windows\HTRA_API_Example\HTRA_C++_Examples\HTRA_C++_Examples.

> Windows > HTRA_API_Example > HTRA_C++_Examples * ~ O | Search HTRA C++.

Name - Date modified Type Size

5/14/2025 1:53 PM  [&] ASG_CWOutput.cpp 6/12/2024 436 PM C++ Source File 4KB

5/14/2025 1:53 PM_| [c] DET_GetPowerTrace_Adaptive.cop 6/12/2024 436 PM C++ Source File 7KB

@l Guides for AP| Examples.pdf 4/29/2025 257 PM [¢] DET_GetPowerTrace_FixedPoints.cpp 6/12/2024 436 PM C++ Source File 7KB

&8 HTRA C++_Examplessin /2024 5:31PM [ DSP_AMDemod.cpp 6/12/2024 5:01 PM C++ Source File 8 KB

=] DSP_DDC.cpp /30/2025 10:39 AM C++ Source File 8KB

@ DSP_FMDemod.cpp 6/12/2024 4:46 PM C++ Source File 8KB

=] DSP_IQSToSpectrum.cpp /30/2025 10:42 AM C++ Source File TKB

@ DSP_LPF.cpp /30/2025 10:44 AM C++ Source File 8KB

g example.h /29/2025 1:25 PM C Header Source F... 1KB

] HTRA_C++_Examplesvcxproj 6/12/2024 537 PM VC++ Project 9KB

Bi HTRA_C++_Examples.vcxpraoj filters 4/29/2025 1:26 PM VC++ Project Filte... 3KB

) HTRA_C++_Examples.vexproj.user 6/12/2024 5:37 PM Per-User Project O.. 1KB

& 10S_GetlQ_Adaptive.cop 6/12/2024 4:40 PM C++ Source File 7TKB

@ 1Q5_GetlQ_FixedPoints.cpp /30/2025 11:05 AM C++ Source File 7KB

@ main.cpp 4/30/2025 10:29 AM C++ Source File 1KB

@ RTA_GetRealTimeSpectrum_Adaptive.cpp 6/12/2024 440 PM C++ Source File 7KB

@ RTA_GetRealTimeSpectrum_FixedPoints.c..  6/12/2024 4:41 PM C++ Source File 7KB

=] SWP_GetSpectrum_Standard.cpp 6/12/2024 4:41 PM C++ Source File TKB
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1.2 Usage Process for C++ Examples

1.2.1 Usage of General C++ Examples

The usage process for general C++ examples included on the USB drive is as follows:
1. Use Visual Studio to open the solution HTRA_C++_Examples.sin located in the
folder Windows\HTRA_API_Example\HTRA_C++_Examples on the provided USB

drive.

o > - IWindows > HTRA_AP|_Example > HTRA C++_Examples > HTRA_C++_Examples >|

T Sort ~ = View ~
Name h Date modified Type Size
htra_api 1/16/2025 2:06 PM File folder
HTRA_C++_Examples 1/16/2025 2:.07 PM File folder
| BB HTRA C++_Examplessin 6/7/2024 5:58 PM visual Studio Solut.. 2k |

2. Click on the right side to access the HTRA_C++_Examples project and click on the

main.cpp file within it.

3. Each routine in the C++ example is encapsulated in a separate function. To use
the example, simply uncomment it (multiple examples cannot be used
simultaneously). For instance, when testing the Device_GetDevicelnfo routine,

uncomment it, save, select the expected compilation architecture (both x86 and
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x64 are acceptable), and click run. The image shown indicates that the device is

running normally.

1.2.2 Use of the AM/FM demodulation example

1. Open the solution Htra_Demodulation.sIn in the folder
Windows\HTRA_C++_Examples\Htra_Demodulation on the supplied USB drive

using Visual Studio.

G & > - | Windows > HTRA_C++_Examples > Htra_Demodulation >
s Tl Sort ~ = View >
Name Date modified Type Size
htra_api 2025/1/20 11:46 File folder
Htra_Demodulation 2025/3/5 11:35 File folder
o Htra_Demodulation.sIn 2025/3/5 11:35 Visual Studio Solution 2 KB

2. Click on the HTRA_C++_Examples project on the right and click on the main.cpp
file.

3. C++send with the example of each routine is encapsulated in a separate function,
the use of the example can be uncommented (not at the same time to use more
than one example). For example, to test the DSP_FMDemod routine, uncomment
it and save it, select the compilation architecture (both x86 and x64), and click

run.
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1.2.3 Usage of the recording and playback example

1. Open the solution Htra_RecordingandPlayBack.sln located in the folder
Windows\HTRA_API_Example\Htra_RecordingandPlayBack on the provided USB

drive using Visual Studio.

USB Drive (E) »| Windows » HTRA_C++_Examples > Htra_RecordingandPlayBack > Searct
Tl Sort = View
Name Date modified Type Size
htra_api File folder
Htra_RecordingandPlayBack File folder
48 Htra_RecordingandPlayBack.sln 12/25/2024 3:14 PM Visual Studio Solution 2KE

2. Click on the right side to access the Htra_RecordingandPlayBack project and click
on the main.cpp file within it.

3. Eachroutine in the recording and playback example is encapsulated in a separate
function. To use the example, simply uncomment it (multiple examples cannot be

used simultaneously).

1. Usage of the reading example:

1) For example, when reading SWP mode stream disk data, uncomment the
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SWPMode_PlayBack function and save.

2) Place the recorded file data from SWP mode into the folder

"Windows\HTRA_C++_Examples\Htra_RecordingandPlayBack\Htra_Recordingan
dPlayBack\data".

HTRA_C++_Examples > IHtra_RecordingandPIayBack > Htra_RecordingandPlayBack > data I

Sea
] M Sort ~ = View ~

~
Name

Date modified Type

ID 004d_20250116_105012.part1.spectrum 1/16/2025 10:50 AM SPECTRUM File 12,568 KB I

3) Click to enter SWPMode_PlayBack.cpp and modify the name of the recorded file

in the SWPMode_PlayBack() function.

4)

Running the program will generate the parsed data file "SWPMode_Data.txt" in

the data folder under the SWP mode.
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o > HTRA_C++_Examples >| Htra_RecordingandPlayBack > Htra_RecordingandPlayBack > datal

T Sort - = View ~ ses
~
Name Date modified Type Size
D 004d_20250116_105012.part1.spectrum 1/16/2025 10:50 AM SPECTRUM File 12,568 KB
I =] SWPMode_Data.txt 1/17/2025 12:00 PM Text Document 3,690 KB I

2. Usage of the recording example:

1) Forexample, when testing the IQSMode_Recording routine, uncomment and save.

2) Click to enter the IQSMode_Recording() function, configure the parameters, and
run the program. You can find the recorded file data in the

"Windows\HTRA_C++_Examples\Htra_RecordingandPlayBack\Htra_Recordingan

dPlayBack\data" folder under the 1QS mode.

Q > HTRA C++ Examples > IHtraiRemrdingandPlayBack > Htra RecordingandPlayBack > data I <
T Sort ~ = View ~ pee
=
Name Date modified Type Size
D 004d_20250116_105012.partl.spectrum 1/16/2025 10:50 AM SPECTRUM File 12,568 KB
I |2| 004D_20250117_134449 part1.iq.wav 1/17/202 File 85,874 KB
|=] SWPMode_Data.txt 1/17/2025 12:00 PM Text Document 3,690 KB
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1.3 Device-related

1.3.1 Get device information

Device_GetDevicelnfo.cpp: Get device information, including APl version, USB version,

device model, device UID, MCU version, FPGA version, and device temperature.

1.3.2 Device standby

Device_SysPowerState.cpp: An example of setting the device's standby state, which

can be configured to normal operating state or RF powered down state (low power).

1.3.3 GNSS-related

Device_AboutGNSS.cpp: Retrieves information such as latitude, longitude, altitude,
and time obtained from the GNSS module, acquires GNSS-related latitude and time
information from MeasAuxinfo in SWP mode, and obtains latitude and time

information from 1QStream.DeviceState in 1QS mode.

1.3.4 Get and modify the IP address of the NX device

Device_GetAndSetIP.cpp: Retrieve the device's IP address and modify it using the

device UID or the device's current IP address.

1.3.5 Mode switching time consumption

Device_MeasureModeSwitchTime.cpp: Get the time required for the current host

computer to switch between different modes.

1.4 SWP mode

1.4.1 Standard spectrum acquisition

SWP_GetSpectrum_Standard.cpp: Obtain spectrum data by calling the function
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interface.

1.4.2 Simplified configuration mode

SWP_EZGetPartialSweep.cpp: Quickly acquire spectrum data using a simplified

configuration.

1.4.3 Maximum and minimum hold

SWP_MaxHold_MinHold.cpp: Set the trace mode to MaxHold or MinHold, and use

SWP_ResetTraceHold to reset the hold.

1.4.4 Average Trace
SWP_TraceAverage.cpp: Average processing of the acquired trace.
1.4.5 Automatic Configuration Measurement

SWP_AutoSetMeasure.cpp: Automatically configures relevant parameters based on
specific SWP applications, completing measurements by issuing automatic

configuration parameters.

1.4.6 Frequency Compensation

SWP_SetFreqCompensation.cpp: When an external attenuator is present,
compensation can be applied to the corresponding frequency band to ensure that the

test results remain accurate.

1.4.7 Function execution time, sweep speed, and throughput

SWP_TimeOfSetFunction.cpp:Obtains the call duration of the SWP_Configuration,
SWP_GetPartialSweep, and SWP_GetFullSweep functions, along with the sweep

speed and throughput under the current configuration.
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1.4.8 Obtain spectrum peak values

SWP_PickMaxPower.cpp: Obtain the maximum power point of the current spectrum

and its corresponding frequency point.

1.4.9 Signals and Spurious

SWP_GetSpectrum_SigAndSpur.cpp: This can distinguish between signals and

spurious after obtaining spectrum data.

1.4.10 Simultaneous Acquisition of Spectrum and 1Q

SWP_GetSpectrumAndIQS.cpp: This allows for the simultaneous acquisition of

spectrum data and IQ data.

1.4.11 Reading SWP Stream Disk Data from Application Software

SWPMode_PlayBack.cpp: This can read the recorded file data in SWP mode from

Application Software and write the read spectrum data into SWP Mode_Data.txt.

1.4.12 Using GNSS 10MHz Reference Clock

SWP_GNSSReferenceClock.cpp: This uses a high-quality GNSS module's 10MHz

reference clock in SWP mode.

1.4.13 External Trigger Mode

SWP_GetSpectrum_Trigger.cpp: This obtains spectrum data when the trigger source is

set to external trigger.

1.4.14 Trace Alignment Method

SWP_GetSpectrum_TraceAlign.cpp: Obtain spectrum data when the trace alignment

method is set to align to the starting frequency or align to the center frequency.
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1.4.15 Number of Spectrum Frames Obtainable within a Certain Time

SWP_Fixedtime_GetFrames.cpp: Loop 50 times to obtain 10 seconds of spectrum data,
resulting in the average number of spectrum frames that can be obtained within 10

seconds.

1.4.16 External Trigger Calibration of Internal 10MHz Reference Clock

SWP_GetSpectrum_Calibration.cpp: An example of the device calibrating the clock via

GNSS-1PPS or through external trigger.

1.4.17 Phase noise measurement

SWP_Meas_PhaseNoise.cpp: Measuring the single-sideband phase noise (unit:
dBc/Hz) of the received signal at the user-specified frequency deviation, supports

multi-frequency point configuration.

1.4.18 Channel power measurement
SWP_Meas_ChannelPower.cpp: measures the channel power of the received signal.
1.4.19 Adjacent Channel Power Ratio Measurement

SWP_Meas_ACPR.cpp: measure the adjacent channel power ratio of the received

signal.

1.4.20 Percentage occupied bandwidth Measurement

SWP_Meas_OBW.cpp: measures the occupied bandwidth of the received signal in

percentage.

1.4.21 XdB Occupied Bandwidth Measurement

SWP_Meas_XdBBW.cpp: measures the occupied bandwidth of the received signal in

XdB.
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1.4.22 IM3 measurements
SWP_Meas_IM3.cpp: IM3 measurement of the received signal.
1.4.23 Frequency interval matching RBW

SWP_RBW_Spaced_Trace.cpp: makes the frequency interval between two points of

the trace close to the set RBW value.

1.4.24 Using an External 10MHz Reference Clock

SWP_RefCLKSource_External.cpp: use external 10MHz reference clock. (Take the use
of external 10MHz reference clock in SWP mode as an example, the same method is

used in other modes).

1.51QS Mode

1.5.1 Obtain Fixed Number or Continuous Stream of 1Q Data

IQS_GetlQ_Standard.cpp: Obtain a fixed number or continuous stream of 1Q data

under professional configuration.

1.5.2 Simplified configuration mode

IQS_GetlQ_EZStandard.cpp: Quickly obtain 1Q data using a simplified configuration.

1.5.3 1Q data converted to voltage V units

IQS_ScalelQDataToVolts.cpp: Converts the acquired IQ data into data in volts (V).

1.5.4 Time taken to issue configuration and acquire IQ

IQS_ConfigandGetlQ_Time.cpp: Obtains the call duration of the IQS_Configuration

and IQS_GetlQStream_PM1 functions.
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1.5.5 1Qto Spectrum Data

DSP_lQSToSpectrum.cpp: Converts the acquired time-domain 1Q data into spectrum

data using spectral analysis methods.

1.5.6 1Qto Spectrum (using liquid library version)

IQS_ToSpectrumByLiquid.cpp: Uses the liquid library to convert the acquired time-

domain 1Q data into spectrum data through spectral analysis methods.

1.5.7 FM Demodulation Playback

DSP_FMDemod.cpp: Performs FM demodulation on the IQ data and plays the

demodulated audio.

1.5.8 FM Demodulation Data Analysis

IQS_FMDataAnalysis.cpp: Audio analysis of the IQ data after FM demodulation to get

the audio voltage, audio frequency, SINAD and total harmonic distortion.

1.5.9 AM Demodulation Playback

DSP_AM_Demod.cpp: Performs AM demodulation on 1Q data and plays the

demodulated audio.

1.5.10 AM Demodulation Data Analysis

IQS_FMDataAnalysis.cpp: Audio analysis of the 1Q data after AM demodulation to get

the audio voltage, audio frequency, SINAD and total harmonic distortion.

1.5.11 Digital Downconversion

DSP_DDC.cpp: Resamples the obtained I1Q data.
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1.5.12 Digital Low-Pass Filter

DSP_LPF.cpp: Perform low-pass filtering on the obtained IQ data.

1.5.13 Audio Analysis

IQS_AudioAnalysis.cpp: Performs audio analysis on the demodulated 1Q data to obtain

audio voltage, audio frequency, SINAD, and total harmonic distortion.

1.5.14 Read the IQS stream disk data from Application Software

IQSMode_PlayBack.cpp: Parses the recorded file data in IQS mode from Application

Software and writes the read spectrum data into the IQSMode_Data.txt file.

1.5.15 Record IQ data in .wav format
IQSMode_Recording.cpp: Stores the acquired 1Q data in .wav format.
1.5.16 .wav changed to .csv

IQSMode_WavToCsv.cpp: Parses and extracts | and Q channel data from the .wav

recording file data in IQS mode, converting it into a .CSV format file for saving.

1.5.17 Streaming and reading IQ data
IQS_GetlQToTxt.cpp: Writes the obtained IQ data into a .txt file.
1.5.18 Multithreaded acquisition, processing, and streaming of IQ data

IQS_Multithread_GetlQ_FFT_Write: Simultaneously acquires I1Q data, performs FFT,

and writes |Q data into a .txt file.

1.5.19 GNSS1PPS trigger

IQS_GNSS_1PPS.cpp: Configure the trigger source to be the 1PPS signal provided by

the internal GNSS system.
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1.5.20 1QS multi-device synchronization

IQS_MultiDevSync_fixed.cpp: Multiple devices simultaneously collect the same signal

at the same time.

1.5.21 External Trigger

IQS_ExternalTrigger.cpp: Configure the trigger source as external trigger.
1.5.22 Timer Trigger

IQS_TimerTrigger.cpp: Configure the trigger source as timer trigger.
1.5.23 Level Trigger(pre-trigger)

IQS_LevelTrigger_PreTriggerr.cpp: configure the trigger source as level trigger and set

the pre-trigger time.
1.5.24 Level Trigger (Trigger delay)

IQS_LevelTrigger TriggerDelay.cpp: configure the trigger source to be level trigger and

set the trigger delay time.

1.5.25 Using GNSS 10MHz Reference Clock

IQS_Enable_GNSS_10MHz.cpp: Use a high-quality GNSS module's 10MHz reference

clock in 1QS mode.
1.5.26 Fixed Step Multi-Frequency IQ Data Acquisition

IQS_SetFreqgScan: Configure the start and end frequencies and frequency points of IQ
in advance. After configuring once, the data will be collected sequentially according to

the set frequency points.
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1.6 DET Mode

1.6.1 Obtain detection data for fixed points or continuous streams.
DETMode_Standard.cpp: Obtain detection data for fixed points or continuous streams.
1.6.2 Simplified configuration mode

DETMode_EZStandard.cpp: Quickly obtain detection data through a simplified

configuration.

1.6.3 Read the DET stream disk data of Application Software

DETMode_PlayBack.cpp: Read the recorded files in DET mode from Application

Software and output the detection data to the DETMode_Data.txt file.

1.6.4 Pulse detection (to be opened later)

1.7 RTA mode

1.7.1 Obtain real-time spectrum data for fixed points or continuous

stream

RTAMode_Standard.cpp: Obtain real-time spectrum data for a fixed number of points

(duration) or continuous stream.

1.7.2 Simplified configuration mode

RTAMode_EZStandard.cpp: Quickly obtain real-time spectrum data through simple

configuration.

1.7.3 Read the RTA stream disk data of Application Software

RTAMode_PlayBack.cpp: Read the recorded file data in RTA mode from Application
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Software, while being able to specify reading a certain packet of data, and write the

read spectrum data to the RTAMode_Data.txt file.
1.7.4 Time consumption of each frame of data in RTA mode

RTAMode_Standard_perframe.cpp: Acquire 100 frames of data and calculate the

average processing time for each frame.

1.8 ASG Signal Source (optional)

1.8.1 Output single tone/sweep/power scan signals

ASG_SignalOutput.cpp: Output single tone/sweep/power scan signals as needed.

2. Digital Demodulation (optional)
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3. Qt

3.1 Configure Development Environment

1. Asshown in the figure, first create a new folder to store the entire project (taking
QtTest as an example, it is recommended not to use a Chinese path), and then

create a htra_api folder within the folder to store the dynamic link libraries and

calibration files.

) > QtTest >
T Sort ~ = View ~ sen
Name Date modified Type Size
htra_api 12/30/2024 7:35 PM File folder

2. Copy all files from the Windows\HTRA_API\x64\htra_api folder on the USB drive
to the newly created QtTest\htra_api folder (taking the x64 architecture program
as an example; for the x86 architecture program, simply copy the corresponding

architecture's libraries).

[J > USBDrive(F) > IWl'ndows > HTRALAPI > x64 > htraapi Search htra

T Sort ~ = View - ses
Name - Date modified Type Size
CalFile 11/29/2024 10:27 AM File folder
@ htra_api.dll 11/25/2024 2:01 PM Application extension 1,133 KB
(i htra_apih 11/25/2024 1:58 PM C/C++ Header 141 KB
¥ htra_apilib 11/25/2024 2:01 PM Object File Library 47 KB
@ libiomp5md.dll 4/30/2024 3:30 AM Application extension 2015 KB
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o > IQtTest

]

> htra_api

i)

Name
CalFile
[%] htra_api.dil
] htra_api.h

B hira_apilib

<] libliquid.dil

Tl sort ~

[%] libiomp5md.dil

.

View ~
Date modified
12/30/2024 7:18 PM
11/25/2024 2:01 PM
11/25/2024 1:58 PM
11/25/2024 2:01 PM
443072024 3:30 AM

1/12/2024 8:37 AM

Search htra_

3.

Open Qt Creator, click on File, and select New File or Project.

65 Ot Creator
JLC Ecit View Build Debug Analyze Jools \Wndow Help
D New Project Carl ShifteN
D NewFile N
@ Open File or Project. 0 Qt Creator
Open File With,
Open From Device.
Open Viorkspace. 152 MSVC2019 64bit
Recent Fies ’
Recent Projects ’
Sgssions. v lred
| Tr——
o
fess Book Example
dress ancrond ook
X &t s
t Themes Example

A Online Community

»»»»» Search Results 3

4.

2 New Project - Qt Creator

Choose a template:

-y

Analog Clock Window Example

Application Output

Bars Example

Application Example

(0]

HTTP Bxample
Tage http network

4 Compile Output 5 Ten

Select Create Form Application.

JSON Save Game Example

¢ | 7l

Wiould you lice 1o take & quick UI tour? This tour highlights important user interface elements and shows how they are used. To take the tour later, select Help > Ul Tour,

Type Size

File folder

Application extension 1,133 KB
C/C++ Header 141 KB
Obiject File Library 47 KB
Application extension 2,015KB
Application extension 739 KB

- o0 x

Bluetooth Low Energy Heart Calendar Widget Example

ag=: bluetooth energy game heart sgx: clendar io wicget widgets

Code
Sample

Local Fortune Client Example Local Fortune Server Example

Take Ut Tour Do Not Show Again X

L]

All Templates

| Projects

Ot Widgets Application

Creates a widget-based Qt
application that contains a Qt

| | Application (Qt for Python)
Library

Other Project

MNon-Qt Project

| | TestProject

Import Project

Qt Console Application

Widgets Designer-based main
window and C++ source and header
files to implement the application
logic.

Preselects a desktop Qt for building
the application if available.

Supported Platforms:

® Desktop

Cancel
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5. After filling in the project name, click Browse to change the project path.

Widgets Application

Project Location
Dl Location

Build System This wizard generates a Qt Widgets Application project. The application derives by default
o from QApplication and includes an empty widget.
Details

Translation

Kits

Summary

I Mame: Test I
Create in:  C\Users\60536\Documents

[] Use as default project location

Next Cancel

6. Select the directory as the QtTest address created in the first step and click Open.

@ Choose Directory X
&« -5 v T » Desktop > QtTest > ~ (&} Search QtTest P
Organize ~ New folder = - (2]

5 Name Date modified Type Size
3 htra_api 12/30/2024 7:35 PM File folder
Test 1/8/2025 4:56 PM File folder
@l Desktop

i Downloads

»

»

= Documents #
P rictures »
»

o Music

¥ viidane -

Folder: QtTest

Select Folder Cancel

7. After selecting the path, click Next.
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Widgets Application

Project Location
Bl Location

Build System This wizard generates a Qt Widgets Application project. The application derives by default
o from QApplication and includes an empty widget.
Details

Translation

Kits

Summary

Name: Test

[Create in: C:\Users\60536\Desktop\QtTest | Browse...

[J Use as default project location

Next Cancel
8. Select gmake and click Next to continue.
X
&« Widgets Application
| b
Define Build System
Location
> Build System Build system: |gmake -
Details qmake ]
_ ) CMake
ranslation
Qbs
Kits
Summary
MNext _ Cancel

9. Click Next to continue.
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« Widgets Application

Class Information

Location
Build System Specify basic information about the classes for which you want to generate
[ Details skeleton source code files.
Translation
Kits Class name: MainWindow
Summary Base class:  QMainWindow v
Header file: mainwindow.h
Source file:  mainwindow.cpp
Generate form
Form file: mainwindow.ui
Next Cancel
10. Click Next to continue.
X
&« Widgets Application
Translation File
Location
Build System If you plan to provide translations for your project's user interface via the Qt Linguist tool,
Details select a language here. A corresponding translation (.ts) file will be generated for you.
> Translation Language: <none= s
Kits Translation file: <none=>
Summary
MNext Cancel

11. Select a build environment for the project and click Next to continue.
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« Widgets Application

Kit Selection
Location
Build System The following kits can be used for project Test:
Details (] select all kits |'-,-':Je to filter kits by name...
Translation
DI Kits (J * Desktop Qt 5.15.2 MinGW 64-bit Details ¥
Summary
Desktop Qt 5.15.2 MSVC2019 64bit Details &

Debug st\build\Desktop_Qt_5_15_2_MSVC2019_64bit-Debug Browse...

Release ;t\build\Desktop_Qt_5_15_2_MSWVC2019_64bit-Release Browse...

B profile  =st\build\Desktop Qt 5 15 2 MSVC2019 64bit-Profile Browse

Next Cancel

12. Click Finish to create the project.

&« Widgets Application

Project Management
Location

Build System Add as a subproject to project: <None=
Details
Translation
Kits

Add to version control: <None>

B> Summary
Files to be added in

C:\Users\60536\Desktop\QtTest\Test:

main.cpp
mainwindow.cpp
mainwindow.h
mainwindow.ul
Test.pro

~ | | Configure...

13. Click Edit, right-click the Test project, and click Add Library.
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3 main.cpp @ Test - Qt Creator - 8 x
File Eait View Buld Debug Anshae Tools Window Help

? “mainwindow.h*

Build
Lo b <Qapplica
Deploy
Fun bint arge, char sargv[])

Rebuild blication af
Clean IWindow w;
pow();
brn a.exec);

avli

Add New.
Add Esisting Files,

‘Add Existing Directory.

Close All Files in Project “Test”
Close Project “Test”

Find in This Disectory.
Sheow in File System View
Open Command Prompt Here
Open Command Promgt With
Expand

Collapse Al

Expand All

Find Unused C/C+-+ Functions

Would you like to take a quick UI tour? This tour highlights important user interface elements and shows how they are used. To take the tour later, select Help = Ul Tour. Take Ul Tour | Do Not Show Again| X
c " .

2 Search Applicaticn t 4 Compil E : 1

14. Select External Library and click Next.

@
File Edit View Build Debug Anshze Tools Window Help

#include <QApplication

~ % Souces
& maincep ~ ot main(int arge, char +argv(])
- mainwindow.pp :
% i Qpplication atarge, argv);
MainWindow w;
w.show();
x
eturn a.exec();
} Add Libr:
forary

Library Type
Dl Type
Choose the type of the library to link to
Intem ibrary

Links to 2 library that is kocated in your buikd

tree.
Adds the library and include paths to the 10
© External library

Links to 3 ibrary that s not located in your build

tree.
Adds the library and include paths to the pro

T System ibrary
Links to 3 system kbrary.

Neither the path 10 the Bbrary
includes s added 1o the pro file

or the path to it

H

and shows how they are used. To take the tour later, select Help > U Tour, Take Ul Tour | Do Not Show Again X

15. Click Browse Library File.

[
File Edit View Build Debug Anahyze Tools Window Help
ect - Y= B B maincop - main{nt, char ) -> int - # CRIF [5] & Line:1,Co
v e Test 1 #include "mainwindow.h" i
& Testpro
» Headers #include <QApplication
~ % Souces
B ~ int main(int arge, char +argv(])
+ mainwindow.cpp
s Qapplication alarge, argv);
Mainkindow wj
w.show();
eturn a.exec(); X
} & Add Library
External Library
Type
DI Detais Specify the fibrary to fink to and the includes pat
Ubrary type: | Windows (*4b 16*.2)
Ubrary file
Include path: | Browse.
Platiorm: Linkage: Dynamic
8 Linux © Oynamic Static
8 wac Mac: Library
—— B Windows @ rary Framework
e —
- main.cpp Windows:
8 Uibrary inside “debug” or “release” subfolder
Add " suffx for debug version
Remove “d” suffix for release version
Cancel
Wiould you lie to take & quick Ul tour? This tour highlights important user interface elements and shows how they are used. To take the tour later,select Help > Ul Tour. Take U Tour | Do Not Show Again X
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16. Select the htra_api.lib library in QTest\htra_api and click Open.

@ Choose File

&« =5 v D > Desktop > QtTest > htra_api > v @]

Search htra_api yel

Organize ~ New folder =- 0 0
~ @ Juanjuan - Perso Name a Date modified Type Size
3 - CalFile 12/30/2024 9:.01 PM File folder
N B8 htra_api.lib 11/25/2024 201 PM Object File Library 47
N ¥ libliquid.lib 1/12/2024 8:37 AM Object File Library 1,580
¥ libmkllib 4/30/2024 3:30 AM Object File Library 6
@ Desktop »
L Downloads #
— Documents #
W pirtirac »
File name: |htra_api.lib V| Windows (*lib lib*.a) v

17. Uncheck all options in Windows, click on Static Library, select the Windows

platform, and click Next.

@
file Edit View Buld Debug Anshze Tools Window Help
[ ST = Ea B Testono
- s Test main.cpp \
& Testpro mainwindow.cpp

+ Headers
HEADERS += \
mainwindow.h

v % Sources
& maincpp
+ mairwindow.cpp

FoRMS +=
¥ Forms \

mainwindow. ui

# Default rules for deployment. x
arget.path = /tmp/$S{TARGET
else: unix:!android: target.path € Add Library

pty(target.path): INSTALLS +

External Library
win32: LIBS += -L$SPWD/../htra_ap Type

Dl Details Specify the fibrary to link to and the includes path

INCLUDEPATH += $SPWD/.. /htra_api

DEPENDPATH += $$PWD/../htra_api Ubnry hpe: (Wioas U5 My

Library e 336\Desktop\Qtfest\htra_apihtra_apilib | Browse.
win32: twin32-g++: PRE_TARGETDEPS

elseiwin32-g++: PRE_TARGETDEPS += include path: C:\Users\60536\Desktop\QiTestihtra_api  Browse.

Platform: Linkage: Static

win32: LIBS += -L$SPWD/../htra_ap ] Linux Oynamic

NCLUDI Mac Library

DEPE

ATH += $$PWD/. . /htra_api
TH += $$PWD/. . /htra_api

- mancpp
# Testpro*

win32: iwin32-g#+: PRE_TARGE Windows:

else:wini2-ger: PRE_TARGE

win32: LTBS += -L$SPWD/../htra_ap ") Add “g" suffix for debug version

I
DEPE

EPATH += $$PWD/../htra_api
PATH = $$PWD/../htra_api

Next Cancel
win32:iwind2-g++: PRE_TARGETDEPS 2
elseiwini2-ge+: PRE_TARGETOEPS += SSBWDJ:./NEraLapi/LiBLIDAKL:S

50|

Wiould you lie t0 take & quick Ul tour? This tour highlights important user intertace elements and shows how they are used. To take the tour ater, select Help > Ul Tour.

sy Application Output 4 Compile Output 5 Terminal 9 General Message

18. Click Finish to add the external library.

Take Ul Tour Do Not Show Again X
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o

file Edit View Buid Debug Ansiyze Tools

19. D

& mainepp
+ mairwindow.cpp
¥ Forms

Viould you lie to take a quick Ut tour? This tour

Window _ Help

#include "mainwindow.h"
sinclude <Qapplication
~ int main(int arge, char +argv(])
Qapplication a(arge,
MainWindow wj
how(
x
eturn:8.exec();
}
€ Add Library
Summary
Type
Detais The follawing snippet will be added to the
e
DI summary B
Cancel
y are used. o take the tour laer,select Help > Ui Tour. Take Ui Tour | Do Not Show Again X

haghlights important user interface elements and shows how they

Application Output 4 Compile

elete the last line '"else: win32-g++: PRE_TARGTDEPS+=SSPWD/..

/htra_api/libhtra_api.a".

9 105_ToSpectrumByliquid.pro @ 1Q5_ToSpectrumByLiquid - Qt Creator = %

File Edit View Build Debug Analyze Jools Window Help

olv, 1 B 10T o5 s ¥indow:

~ ¢ 1QS ToSpectrumByLiquid Q1 -
& 1G5 ToSpectrumByLiquid.pro
» " Headers er (QT_MAJOR_VERSION, 4): QT += widgets
~ % Sources
- main.cpp = cesll
~ mainwindow.cpp
»  Forms Vi icam:malih::yourcode) At Ao s P Epeans: i aprecatast ADES
In order to do so, unc Towing Lline.
INES += QT_OISABLE # disables all th ore Qt 6.9
SOURCES += \
main.cpp \
mainwindow. cpp
HEADERS += \
mainwindow.h
FORMS
mainwindow.ui
& Default rules for deployment.
anx: target.path = /tmp/$${TARGET}/bin
unix:tandroid: target.path = /opt/$${TARGET}/bin
tisEmpty(target.path): INSTALLS += target
win32: LIBS += -LSSPWD/../htra_api/ -lhtra_api
INCLUDEPATH += $$PWD/.. /htra_api
ENDPATH += $$PWD/../htra_api
win32-ge+: PRE_TARGETDEPS += $SPWD/../htra_api/htra_api.lib
Tn32-g++: PRE_TARGETDEPS += SSPWD/../htra_spi/Libhtra_api.s ]
34
7 are used. To take the tour later, select Help > UI Tour. Take U Tour || Do Not Show Again | X
Kits > Qt Versices ) Lisk with Qt nk wich Gz || Do ot Show Again | X
e 8 Test Re : 1
3 105_ToSpectrumByLiquid pro @ 105_ToSpectrumByLiquid - Qt Creator = B %

File Edit View Build Debug Analyze JTools Window Help

~ "% 1QS ToSpectrumByLiquid

& 1GS_ToSpectrumBytiquid.pro
« Headers

- main.cpp
- mainwindow.cpp
» Forms

Qr = core gui

sterThan(QT_MAJOR_VERSION, 4): QT += widgets

CONFIG += c++11
# You can make your code fail to compile if it uses deprecated AP
In order to do so, uncomment the following line.

e APIs deprecated be

FINES += QT_DISABLE_DEPRECATED_BEFORE=0x068660  # disables all

SOURCES += \
nain.cpp \
mainwindow. cpp

HEADERS += \
mainwindow.h

FORMS += \
mainwindow.ut

# Default rules for deployment.
qnx: target.path = /tmp/$S{TARGET}/bin
else: unix:ilandroid: target.path = /opt/$S{TARGET}/bin

tisEmpty(target.path): INSTALLS += target

win32: LIBS += -L$SPWD/../htra_api/ -lhtra_api

INCLUDEPATH += $$PWD/.. /htra_api
DEPENDPATH += SSPWD/../htra_ap}

32 win32: fwin32-g++: PRE_TARGETI

S += $3PWD/../htra_api/htra_api.lib

they are used. To take the tour later, select Belp > UI Tour. Take UI Tour | | Do Not Show Amain | X

> Kits > Qt Versions > Link with Link with 0t | | Do

HTRA API Example Usage Guide 37



20. Save the Test.pro file, and then you can write the code normally.

3 mairwindow.cop & Test - Ot Creator
File EGit View Build Debug Anshze Tools Window Help

pedef BootProfile;
ypeDef BootInfo;

Open Documents = 5
& mainwindow.cpp®

21. After writing the code, click Run. The device should function normally as shown

in the figure.

PP © Test - Ot Creator

BootPrafile_TypeDef BootProfile;
BootInfo_Typebef BootInfo;

BeotProfile.DevicePowersupply = USBPortAndPowerPort;

BootPrafile.Physicalln

Jpen Documents -
& mainwindow.cpp

op_Qt_5_15_2_MSVC2019_64bit-Debug\debug\Test.exe. ..

c_dia[e] = -78.6547
m[6] = -83.8580

3.2Qt Example Usage Process

The usage process for the Qt examples included in the USB drive is as follows:
1. As shown in the figure, use Qt Creator to open the htrademo.pro file located in
the Windows\HTRA_API_Example\HTRA_Qt_Examples\htrademo folder on the

USB drive (please ensure the project path does not contain Chinese characters).
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Q

Name

“ mainwindow.ui

> USBDrive (F) > Windows >| HTRA_API_Example

T Sort ~

—
T
]

htrademo.pro

B &

2.

& htrademo - Ot Creator

htrademo.pro.user

SWP_TraceAverage.cpp

File Eoit View Buill Debug Anahze Tools Wimdew Help

Manage Kits

Active Project
hiradema

Import Existing Build
Build & Run

o

2 Build
b Run

& Desktop Qt 5.15.2 MSVCZ...

o
Hige Inactive Kits

Project Settings

Editor

Language Server
Code Style
Documentation Comments
Dependencies
Environment
€=+ File Naming
€=+ Code Model
Clangd

Quick Fixes
Clang Tools
CMake

Testing

3.

Build Settings
Edit build configuration: Debug
General

Shadow build!

Build directory.

Taoltip in target selector:
Separate debug info
QML debugging and profiling

Qt Quidck Compiler:

>  HTRA_Qt Examples > htrademo >|

saa

View ~

Date modified

1/16/2025 9:59 AM
1/16/2025 10:42 AM
1/16/2025 2:51 PM

1/9/2025 9:29 PM

add - Remove || Rensme Clore,

a
The buikd directory should be at the same level as the source directory.

Default
Enable

Defauit

qmake systemi) behavior when parsing: Use global setting

Build Steps

qmake: gmake exe hirademo,pro

Make: jom exein C41 A HTRA_Qt Exemg QL3152 MSVC2019_64bit-Debug
Add Buid Step =
Clean Steps
C TR Desktop Q1 5_15_2 MSVC2018 64bit-Debug

Add Clean Step >

Build Environment
(] Clear system environment

Use System Enviranment

Output 4 Compile Output

5 Terminal 9 Gener

After configuring the build environment, click on Edit,

in the Sources folder of the htrademo project.

file Eait View Build BRI Anshae Tools Window Help

T =

- ASG_Signaiou

& Device_Timed
 Deviec GetDen
& DSP_AMDemo
= DSP_DDC.cpp
- DSP_FhDemo
. DsPIasTaspe
< DSP LPF.cpp

& Eror_handling
= 105 AudioAna
- 105 Configen
- 105 Enatie G
& 105 EstemalTn
o 105_GetiQ_EZS

4.

© main()

B maincpp

Status = 8}

3 Application Qutput_4 Compile Output

5 Terminal 9 Gener

Click on the project to configure a build environment for it.

Might make your apphication wulnerable.
Only use in  safe environment.

Browse..

Detaits ¥

Detaits ¥

Detaits v

Detaits ¥

and then click on main.cpp

Show Details  Open Settings  Start Update | X

Since each example in the Qt provided examples is encapsulated in a separate

function, you can simply uncomment the desired example when using it (multiple

HTRA API Example Usage Guide 39



examples cannot be used simultaneously). For instance, when testing the
Device_GetDevicelnfo example, uncomment it, save, and click run. The image

shown indicates that the device is operating normally.

@ maincpp @ htrademo - Qt Craator o X

file Edi View Buid  Debug  Analyze  Tools Window  Welp

o 1QS_MultiDevs
« 1QS_Multithrea
o 1QS_ScalelQDa
« 1QS_TimerTrigc
« 1QS_ToSpectru
o main.cpp

« mainwindow.c
< RTAMode_EZSt
o RTAMode_Star
« RTAMode_Star
« SWP_AutoSeth
o SWP_Calibrate
<« SWP_EZGetPar
o SWP_Fixedtime
« SWP_GetSpect

o main.cpp

3.3Qt Example Description

The Qt examples on the USB stick include a general example (HTRA_Qt_Example), an
FM and AM demodulation example (HTRA_Demodulation), and an 1Q to Spectrum
example (IQS_ToSpectrumBulLiquid) using the Liquid library, refer to the C/C++

examples chapter for specific examples.
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4. Python

4.1 Configure Development Environment

1. Create a folder on the desktop and name it, for example, test. Open the USB drive
and copy the "HTRA_API" folder and "htra_api.py" file from
"\Windows\HTRA_API|_Example\HTRA_Python_Examples" on the USB drive to

the newly created folder.

o > - | Windows > HTRA_API_Example > HTRA_Python_Examples > Search HTRA_P
N Sort ~ = View v
Name Date modified Size
HTRA_API 1/8/2025 11:03 AM Il

# ASG_CWOutput.py 1/8/2025 11:00 AM 4 KB
% DET_GetPowerTrace_Standard.py 1/8/2025 10:43 AM 6 KB
% Device_GetDevicelnfo.py 1/8/2025 10:45 AM 3 KB
% DSP_IQSToSpectrum.py 1/8/2025 10:56 AM / 7 KB
# htra_api.py 12/9/2024 7:18 PM I 62 KB
%/ 1QS_GetlQdata_Standard.py 1/8/2025 10:37 AM 6 KB
mm python Call HTRA API Manual_CN.pdf 6/17/2024 4:20 PM 587 KB
# RTA_GetRealTimeSpectrum_Standard.py 1/8/2025 10:37 AM 6 KB
# SWPMode Standard.py 1/8/2025 10:06 AM 4 KB

test X T

T G ) > | ThisPC » OS(C) > Users > 60536 > Desktop > test |

@New- ¥ © [ @ W O Nosote = viewe e \

0 Music » Name Date modified Type Size

u Videos » @ ntra_apipy 5/9/2024 6:28 AM JetBrains PyCharm ... 55 KB
IDE HTRA_API 6/17/2024 3:12 PM File folder \
CopyFFW

2. Open Visual Studio Code, click on File and then Open Folder, and open the folder

you just created.
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memoes

1al Studio Code

)o Open Folder X
A~ B > Desktop > v G Search Desktop L
Organize ~ New folder = - 0
~
> 3 Juanuan - Perso Name Date modified Type Size
Launcher 6/14/2024 6:31 PM File folder I
I8 Desktop productbrochure 6/6/2024 4:06 PM File folder
B3 Downloads SaStudiod (0.55.5) 5/29/2024 5:52 PM File folder
3 Documents SAStudio4 (English) 6/4/2024 10:09 AM File folder
P4 Pictures technicalsupportdocuments 5/31/2024 11:35 AM File folder
B Music test 6/17/2024 3:39 PM File folder
3 Videos updater 6/4/2024 1:51 PM File folder
INF
Folder: test

Select Folder Cancel

Create a new Python file.

Visual Studio Code

Write code normally. You can refer to the Python examples included in the USB
drive, specifically in the folder

"\Windows\HTRA_API|_Example\HTRA_Python_Examples" for the project.
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4.2 Python Example Usage Process

The usage process of the Python examples included in the USB drive is as follows:

1. Asshown in the figure, open the entire project using vscode or another compiler
from the USB drive provided:
Windows\HTRA_API_Example\HTRA_Python_Examples. The htra_api.py file in
the project is the mapping file for the dynamic link library in Python, while the
other files are example programs (the role of the examples will be described in

subsequent chapters).

Visual Studio Code
Editing ed

Start Walkthroughs

> OUTLINE

> TIMELINE

X @oAo %o

2. Select any example program, configure the Python environment for it, and run
the program directly. For instance, when using the SWPMode_Standard.py

example, the device is shown to be operating normally as illustrated.
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4.3 Python Example Description

4.3.1 Get device information

Device_GetDevicelnfo.py: Retrieves various device information, including API version,
USB version, device model, device UID, MCU version, FPGA version, and device

temperature.

4.3.2 Obtain Standard Spectrum Data

SWP_GetSpectrum_Standard.py: Obtains complete spectrum data within a specified
frequency band(Plotting the spectrum if the host computer includes the matplotlib

library).
4.3.3 Obtain IQ Data for a Fixed Number of Points or Duration

IQS_GetlQdata_Standard.py: Obtains 1Q data under different trigger modes in 1QS

mode.

4.3.4 Obtain Power Detection Data for a Fixed Number of Points or

Duration

DET_GetPowerTrace_Standard.py: Obtains power detection data under different
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trigger modes in DET mode(Plotting the Time-power graph if the host computer

includes the matplotlib library).

4.3.5 Obtain real-time spectrum data for a fixed number of points or

duration

RTA_GetRealTimeSpectrum_Standard.py: Obtain real-time spectrum data under

different trigger modes in RTA mode.

4.3.6 1Qto Spectrum Data

DSP_IQSToSpectrum.py: Convert the 1Q data obtained in 1QS mode into spectrum
data(lf the host computer contains the matplotlib library then plot the spectrum and

IQ time-domain graphs).

4.3.7 GNSS Related

Device_AboutGNSS.py: Obtain information such as longitude, latitude, altitude, and
time acquired by the GNSS module; obtain the longitude, latitude, and time

information from the MeasAuxInfo structure in 1QS mode.
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5. Matlab

5.1 Configure Development Environment

The method of calling htra_api in 32-bit is basically the same as in 64-bit, so the
following tutorial uses Matlab 2016a as an example to illustrate how to call the 64-bit

htra_api.
5.1.1 Install MSYS2

Download and installation link: https://www.msys2.org/

1. Download the installer MSYS2-x86_64-20231026.exe
2. Run the installer. MSYS2 requires 64-bit Windows 8.1 or higher.

3. The default installation path is C:\msys64, but you can choose a different path as

needed.
*
M5Y52 Setup
Installation Folder
Installation Fold
fon Folder Please specify the directory where MSYS2 will
Start Menu shortcuts be installed.
C:\msyssd Browse. ..
Installing
Finished
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4. Once completed, click Finish.

MSYS2 Setup

Installation Folder
Start Menu shortcuts
Installing

Finished

Completing the MSYS2 Wizard

Click Finish to exit the MSYS2 Wizard.
Run M3YS2 now.

[ Enish |

5.  Now, MSYS2 is ready, and the terminal for the UCRT64 environment has started.

6. Toinstall the GCCtools, enter the command: pacman -S mingw-w64-ucrt-x86_64-
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7. The terminal window will display the following output. Press "Enter" to continue.

mingw-w
dependencies
for conflictir

-gmp

-Tibiconv

-mpfr

Total Download Size:
Total Installed Size:

3
o haia
e

8.

T R T W B W TR W R W W W
SAESEASRESEAEEREESTE
e e e e e e e e e

5.1.2 Configure Matlab

1. Solve the case of Matlab 2016a opening .m file with Chinese garbled code.
Note: If you are using a version of Matlab higher than 20193, ignore this step.
1) View the current coding format:

At the Matlab command line type: feature('locale')
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Command Window ®

feature

JvmEncoding: ‘G

status: 'MathWorks locale management system initialized '

® b ®m B ®mow

warnin

S |

As you can see from the figure, the encoding format is GBK.

2) Right-click on the Matlab2016a shortcut and select "Open File Location" to open
the folder where Matlab.exe is located.

3) In the folder shown in step (2), find lcdata.xml and Icdata_utf8.xml, rename
Icdata.xml to Icdata_old.xml, i.e., backup the original Icdata.xml.

4) Make a copy of Icdata_utf8.xml and put it in the same level folder, and rename
the newly copied file Icdata_utf8.xml to Icdata.xml.

5) Open Icdata.xml and delete the GBK related code shown below.

6) Find the "UTF-8" part, add the code in the marked line to the corresponding

position in the figure, save lcdata.xml and close the file.

7) After restarting Matlab, the garbled Chinese is back to normal.
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2. Configuration of the compilation environment Method 1: Configuration in scripts:
At script runtime, run setenv('MW_MINGW64_LOC', ' D:\msys64\ucrt64') and the mex

-setup C++ command to configure the compilation environment for C++.

SWPMode_Standard.m +
1 % Confioure the compilation environment
2 — setenv (' MW MINGW64 LOC,’ D:\msys64\mingw64 ) ;
gll= mex —setup C++
4
5— filePath = fullfile(pwd, "htra_api mat’);
6
7 % Check if the folder exists, and if not, create the folder
8 — if Texist(filePath, ’dir’)
9— mkdir(filePath); % Create a destination folder
10 — run(’ htra_api.m ) ;
1 — filePath = fullfile(pwd, "htra_api mat’);
2= end

Note: D:\msys64\ucrt64 is the folder where the compilation environment is located.
Please check if there are files such as c++.exe, g++.exe, and gcc.exe in the bin folder at
this address. If they exist, this address is the compilation environment address; if not,
please find the correct address of the compilation environment.

3. Configuration of the compilation environment method Il: startup.m file modified.
1) In the Matlab terminal, input: userpath, and the command line window will

output a result similar to: C:\Users\YourUsername\Documents\MATLAB
Command Window

»> userpath
ans =

C:\Users\ \Documents‘\MATLAB;
f;; >

2) Checkif the startup.m file exists at C:\Users\YourUsername\Documents\MATLAB.
If it does not exist, create a new startup.m file at this location. The steps for
creation are as follows:

i Matlab terminal input: cd('C:\Users\YourUsername\Documents\MATLAB'),

HTRA API Example Usage Guide 50



switch the working directory to C:\Users\YourUsername\Documents\MATLAB.

Command Window

>> userpath

ans =

C:\Users\ » * \Documents‘\MATLAB;

»> ed( C:\Users) \Documents‘\MATLAB" )

_f;g>>|

ii. Matlab terminal input: edit startup.m, select "Yes" in the pop-up window to

create the startup.m file.

Command Window 4\ MATLAE Editor X
22> userpath
9 File C:AUsers\#8\Documents\MATLAB\startup.m does not exist.
‘ Do you want to create it?

_| Do not show this prompt again.

ans =

C:\Users\* © ‘Documents‘\MATLAB;

»> c¢d(’ C:\Users\ \Documents‘\MATLAB )
>> edit startup.m

Jx

iii. Add commands in the startup.m file:

setenv('MW_MINGW64_LOC', 'D:\msys64\ucrt64'); and mex -setup C++.

Ll L T T
EDIT BREAKFOINTS RUMN

iments + MATLAB
Ei Editor - C\Users\" " \Documents\MATLAB\startup.m

| startup.m I
1-— ‘setenv (" MW_MINGW64 LOC’, ’'D:‘\msys64\ucrt64’);
D= mex —setup C++;
iv. After editing the startup.m file, save and close it.
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V. Restart Matlab, and observe that the command line window appears as shown

in the figure below, indicating that the configuration is complete.

MEX configured to use *MinGW64 Compiler (C++)’ for C++ language compilation.
Warning: The MATLAB C and Fortran API has changed to support MATLAB

variables with more than 2732-1 elements. In the near future

you will be required to update your code to utilize the
new API. You can find more information about this at:
http://www. mathworks. com/help/matlab/matlab external /upgrading-mex—files—to-use—-84-bit—api. html.

fer

5.1.3 Description of call htra_api.dll

1. loadlibrary
The loadlibrary function can load dynamic link libraries.
loadlibrary('.\htra_api\htra_api.dll',"\htra_api\htra_api.h'); Ensure that the file paths
for .dll and .h are correct.
%Loadhtra_api. dll
if not(libisloaded( htra api.dll’))
%The file paths for .dll and .h files should be carefully noted
loadlibrary (. \htra_api\htra api.dll’,’.\htra_api\htra api.h’);
end
2. libfunctions
libfunctions('htra_api'); This is used to view all available functions in htra_api.dll.

%View all functions in the API

libfunctions (" htra_api’);

3. libpointer
libpointer allows the creation of data type pointers in Matlab and passes them to
external library functions.

%0pen the device

%Create a Device pointer

Device = libpointer;
0;
0

DevNum
Status
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4. libstruct
libstruct is used to define structure types in Matlab and pass them to external library

functions.

%Create a BootProfile structure
BootProfile = libstruct (' BootProfile TypeDef’ );
save (fullfile(folderPath, ' BootProfile. mat’ ), 'BootProfile');

%Create the Devicelnfo structure
Devicelnfo = libstruct(’ DeviceInfo TypeDef’ ) ;
save (fullfile(folderPath, 'DeviceInfo.mat’ ), 'Devicelnfo’):

5. get
The get function is used to retrieve the property values of a structure.

%Call the Device_Open function
Status = calllib( htra_api’, "Device_Open’, Device, DevNum, BootProfile_p, BootInfo_p);
get (BootInfo_p); %Print the value of BootInfo_p

6. calllib

calllib is the command in Matlab used to call functions in htra_api.dIl.

%Call the Device_ Open function
Status = calllib(’ htra_api’, 'Device Open’, Device, DevNum, BootProfile, BootInfo);
get (BootProfile) ;%Prints the value of BootInfo_p

7. load
load is used to load the .mat structure files generated in htra_api.m.

% Load the BootProfile TypeDef structure directly
load(fullfile(filePath, 'BootProfile.mat’));

% Load the BootInfo TypeDef structure directly
load(fullfile(filePath, 'BootInfo.mat’));

8. fullfile
fullfile is a function in MATLAB used to generate full file paths. Load the

BootProfile.mat and Bootlnfo.mat files under the filePath.

% Load the BootProfile TypeDef structure directly
load(fullfile(filePath, 'BootProfile.mat’)});

% Load the BootInfo_TypeDef structure directly
load(fullfile(filePath, "BootInfo.mat'));

9. unloadlibrary

unloadlibrary is used to unload a previously loaded htra_api library, appearing in pairs
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with loadlibrary.

%Unload library file
unloadlibrary(’ htra_api’);
disp(’ Uninstall complete’)

5.2 Matlab example usage process

The usage process for the Matlab examples included on the USB drive is as follows:

1. Open the Windows\HTRA_API_Example\HTRA_Matlab_Examples folder on the
USB drive, and double-click any .m file to open the example. For instructions on
how to run the example, please refer directly to step 4.

2. If you cannot open the example in step 1, please continue to this step and copy

the address Windows\HTRA_API_Example\HTRA_Matlab_Examples.

> - windows > HTRA_API_Example > HTRA_Matlab_Examples > Conrch UTDA Mat
T Sort = View Copy Address as Text
Name Date modified Type Size Edit Address
htra_api m”n v File folder

[ ASG_CWOutput.m M File 7K8 Delete History

[7] CreatPeakiarker.m M File 6 KB

D DETMode_Standard.m M File 6 KB

D Device_QueryDevicelnfo.m M File 5KB

[] DsP_I0SToSpectrum.m M File 7KB

D GMS5_DOCKO_LockState.m M File 5KB

[ htra_apim M File aK8

[] 1a5Mode_ MultiDevSync_Standard.m M File 9KE

D 1Q5Mede_Standard.m M File TKB

D RTAMode_Standard.m M File 6 KB

D RTAMode_Standard_new.m M File 10KE

[7] swPMade_perSminute findMax.m M File 6KB

D SWPMode_Standard.m M File 6 KB

3. Open the Matlab software installed on your system.

MEX configured to use "MinGW64 Compiler (C++)' for C++ language compilation. Hame
Warning: The MATLAB C and Fortran API has changed to support MATLAB

variables with more than 2°32-1 elements. In the near future

you will be required to update your code to utilize the

new APL. You can find more information about this at:

http://www. mathworks. com'help/matlab/matlab external /upgrading-mex-files-to-use-64-bit-api. html.

fx 2 |

4. After pasting the copied address into the file address box, press Enter to navigate

HTRA API Example Usage Guide 54



to the \Windows\HTRA_API_Example\HTRA_Matlab_Examples folder included

with the materials.

4 MATLAR R20162 - c

onfigured to use "MinGW64 Compiler (C++)' for C++ language compilation. Nazie
Warning: The MATLAB C and Fortran API has changed to support MATLAB
variables with more than 2732-1 elements. In the near future

) Device_ QueryDevicelnfo.m you will be required to update your code to utilize the
*') DSP_1QSToSpectrum. = = : =

o e e new API. You can find more information about this at:
) GNSS_DOCXO_Lockstate.m y S
) bhtra_apim

1 10SMode MuliDeveye stnd.. | S > |
*1Q5Mode_Standard.m

4] RTAMode.Standard.m

%) RTAMode_Standard new.m

*) SWPMode _perSminute findM...
] SWoMode_Standard.m

5. Click on the .m file on the left as needed, click "Run", and wait for the Figure 1
window to appear, indicating that the example has run successfully. For the
functional descriptions of each example, please refer to section 5.2 Matlab

Example Description.

Window  Help

n Tool: Desktop

LO9E4A-2 08 =D

5-  filePath = fullfile(pwd, 'htra_api_mat'
7 % Check if the folder exists. and if ng
8 if “exist(filePath, "dir’)

9- run(’ htra_api.uw');

10 - filePath = fullfile(pwd, "htra_api]
11 - end

12

13 %Load htra_api. d11

14— if not(libisloaded(’ hira

15— loadlibrary('. \htra P the file pe
16 — end

GainParameter: 16777223
DSPPlatform: ' FPGA_DSP"

Configuration delivery succeeded
Uninstall complete

5.3 Introduction to Accompanying Examples

5.3.1 Get device information

Device_QueryDevicelnfo.m: Retrieve device information, including APl version, USB
version, device model, device UID, MCU version, FPGA version, and device

temperature.
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5.3.2 Obtain Standard Spectrum Data

SWPMode_Standard.m: Obtain complete spectrum data within the specified

frequency band.

5.3.3 Create multiple markers to display the frequency and power of the

markers.

CreatPeakMarker.m: Obtain spectrum data within the specified frequency band,

create markers, and perform peak searching.

5.3.4 Collect the peak spectrum every five minutes.

SWPMode_per5Sminute_findMax.m: Obtain spectrum data within the specified

frequency band and search for the peak globally every five minutes.

5.3.5 Obtain continuous stream or fixed number of 1Q data.

IQSMode_Standard.m: Acquire IQ data under different trigger modes in IQS mode.

5.3.6 The acquired IQ data is converted into spectrum data.

DSP_IQSToSpectrum.m: After acquiring 1Q data, the obtained 1Q data is converted into

spectrum data.

5.3.7 Acquire continuous stream or fixed number of power detection

data.

DET_GetPowerTrace_FixedPoints.m: Acquire power detection data under different

triggering modes in DET mode.
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5.3.8 Acquire continuous stream or fixed duration real-time spectrum

data.

RTAMode_FixedPoints.m: Acquire real-time spectrum data under different triggering

modes in RTA mode.

5.3.9 Internal signal source output signal.

ASG_CWOutput.m: Output single-tone signals, frequency sweep signals, and power

sweep signals. Applicable only to devices with signal source options.

5.3.10 Lock GNSS antenna and DOCXO oscillator.

GNSS_DOCXO_LockState.m: Call the API interface to lock the GNSS antenna and

DOCXO oscillator, applicable only to devices with |0 expansion board options.

5.3.11 Multi-machine synchronization

IQSMode_MultiDevSync_Standard.m: When using the same reference clock source
input and the same trigger source input, two devices simultaneously acquire 1Q data,

allowing for the observation of the synchronization of their collected data.
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6. CH

6.1 Configure Development Environment

6.1.1 Development Environment Confirmation

Open Visual Studio Installer, check the .NET desktop development components and

Universal Windows Platform development components, and click Modify to ensure

that Visual Studio 2019 has the C# development environment.

ndows
V142 build tools (6 &
fest

(SRl RelfaRcl<]<B< B

edition you selected,
otices or i

6.1.2 Project Setup

1. Open Visual Studio 2019 and click on Create a New Project.

Visual Studio 2019

Open recent Get started

Today
Yesterday
This week

i This month )

'{E‘ Create a new project
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2. Select C# Console Application and click Next.

Create a new project

Recent project templates o Al platforms - Allprojecttypes

[ Windows Forms App (NET Framework) ﬁ Console App (NET Framework)
A project for creating a command-line application
Bi Console App C# | Windows  Console
P o (L ;
58 Class Library (NET Framework) H&! Class Library (NET Framework)
= eating
BS Console App (NET Framewark) Windows  Library
Wi Dynamic-Link Library (DLLY ject (NET Framework)
est unit tests.
X1 Empty Project

er App (NET Framework)
on Foundati

XAML  Windows

Enter the project name and storage location, uncheck the option to place the

solution and project in the same directory. Select .NET Framework 4.5 as the

framework, and finally click Create.

Configure your new project

Console App (.NET Framework) ¢#  Windows  Console
Project name
ConsoleApp1

Location

Solution name (i

ConsoleApp1

Place solution and project in the same directory

Framework

NET Framework 4.5

Create

Once the creation is complete, open the project, right-click on the solution, and

select Add New Project.
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5. Select Class Library (.NET Framework) under Library type for the project type, and
click Next.

Add a new project

Recent project templates All platforms

6. The library name can be modified as needed, such as HtraApi, and the location
should not be changed, remaining at the same directory level as the solution. The

result is shown in the figure, select the .NET Framework 4.5 framework, and click

Create.
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onfigure your new project

Class Library (NET Framework) ¢#  windows

Library

— o X
ConsoleApp1 e aF
T C J > - 60536 > Deskiop > ConsoleAppl > Search ConsoleApp1
@ New ~ ML Sort = View ~ (D Preview
=
> @ Juanuan - Personal Name Date modified Type Size

ConsaleApp1 6/14/2024 2:02 PM File folder
[ Desktop HtraApi 6/14/2024 2:17 PM File folder

ﬁ Downloads =] ConsaleApp1.sin 6/14/2024 3:05 PM Visual Studio Solut... 2KB

7. Right-click on ConsoleApp1 and select Properties.

8. Viewthe project's build properties, change the target platform to x86, click Debug,

enter htra_api\ in the working directory, and save. If the situation in Figure 12

occurs, click OK and save again.
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leApp1® & X Program.cs
Configuration:  Active (Detuy
Bl
General
Conditional compilation symbols:
8 Define DE
8 Define

Allow unsate code
Optimize code
Ervors and warmings

Treat warnings as
O roe
A
Speific warnngs
Outpun
Outpd patte

XML documentation e

Configuraon:  Active (Detwug

0 stn project
Start extemas pregram:
Start browser with URL

Start options

Command line guments

Werking directory:

Use remote machine
Authentication mode:
Detugger engines

Ensble Astive code debugging

Enable SOL Server debugging

JeApp1® 8 % rogamc
Confiquraton:  Actve Dstug

© st pojec
Start extemnal program:
Start browser with URL

Command line srguments

Werking directory:
Use remote machine
Autheritication mode:

Debugger engines

Enatile native code debugging

Enable SL Server debugging

9.

Platfarmc  Active (Any CPU

Miresoft Visual Studio

Right-click on the library HtraApi and select Properties.
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11. Copy the ~contents of the HtraApi.cs file from the folder
\Windows\HTRA_API_Example\HTRA_C# Examples included in the

accompanying materials to the Classl.cs file in the project library and save.
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HTRA_C# Examples X ar

< ™ @] Q > - HTRA_API_Example > HTRA_C# Examples > Search HTRA_C#_Examples
@ New ) TN Sort = View aee (D Preview

B3 Juanjuan - Personal Name Date modified Type Size

CsharpDemo 6/11/2024 8:01 PM File folder

O Desktop HtraApi 6/11/2024 10:16 AM File folder

B3 Downloads packages 6/11/2024 10:51 AM

=3 Documents B C# Call HTRA API Manual CN.pdf 6/11/2024 6:0 WPS PDF 1,730 KB

P Pictures &8 CsharpDemo.sin 6/11/2024 10:20 AM Visual Studio Solu 2KB

B Music E HtraApi.cs 5/2024 6:04 P C# Source File 2 KB

B3 Videos Readme.txt 6/11/2024 5:59 PM Text Document 1KB

12. Select the ConsoleAppl project, right-click on References, and choose Add

Reference.

13. Select the HtraApi library and confirm the addition of the library reference.
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Reference Manager - ConsoleApp1 ? X
b Assemblies

4 Projects Name Path Rames

HtraApi C:\Users\60536\Deskt... HtraApi
Solution

P Shared Projects
b com

b Browse

14. Copy the htra_api folder from \Windows\HTRA_API\x86 on the accompanying
USB drive to the Debug folder under the project's bin folder, and ensure that the

CalFile folder within the htra_api folder contains the calibration files.

x86 x +

&~ g (&) (] >| USB Drive () > Windows > HTRAAPI > x86 > | Search x86

® New - T sort v = View - e \
FPGA Name Date modified Type / Size

Updater | htra_api 3/29/2024 4:59 PM File folder |
Debug X +
& ™ C Q > | Desktop > ConsoleApp1 > ConsoleAppl > bin > Debug > |
@ New - T Sort ~ = View ~ e \
PR pictures Name Date modified Type Size
W) Music | htra_api 6/17/2024 10:59 AM File folder | \
u Videos )
CalFile x |+ B
<« ™ @] Q > | ConsoleAppl > bin > Debug > htra_api > CalFile | <gmss=—s5earch CalFile
@ New ~ M T Sort - = View v e
~ /
FEGA Name Date modified Type Size
Updater |=I 056_4248500a00460020_ifacal.txt 11/14/2023 12:10 PM Text Document 25 KB
|=] 056_4248500a00460020_iqcal.txt 11/14/2023 12:10 PM Text Document 89 kB
~ [ This PC |51 056_4248500200460020_rfacal.txt 11/14/2023 12:10 PM Text Document 5,503 KB

> ¥ 192.168.3.29

15. Write code normally. You can refer to the C# examples included in the
accompanying USB drive, specifically the projects in

\Windows\HTRA_API_Example\HTRA_C# Examples.
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Buld Debug Test Exten window  Help ConsoleAppl

Debug > stant

« Main(string]) arg:

8 Hitrap
8 Microsoft.

stProfile ef();
BootInfo =

tProfile.DevicePowersupply = g 8PortAndPowerPort;

Profile.Physicallnterface

statu _Open

€D CRIF

- ax
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6.2 C# Example Usage Process

The usage process of the C# examples included in the USB drive is as follows:
1. Open the USB drive using Visual Studio and navigate to the folder
Windows\HTRA_API_Example\HTRA_CSharp_Examples, then open the solution

file HTRA_CSharp_Examples.sin.

O > USBDrive(F) > | Windows > HTRAAPI Example > HIRA CSharp_Examples > | Search HTRA_CSharp_E

()] = w T Sort v = View -

~
Name Date modified Type Size

HTRA_CSharp_Examples 1/8/2025 4:11 PM File folder

HtraApi 1/ 25 411 PM File folder

packages 1/8/2025 4:11 PM File folder

Q’E HTRA_CSharp_Examples.sin 11/27/2024 3:58 PM Visual Studio Solution 2 KBI

B HtraApics 7/1/2024 4:13 PM C# Source File 182 KB

=l Readme.txt 6/11/2024 8:15 PM Text Document 1KB

2. Click on the HTRA_CSharp_Examples project on the right side, and then click on

the Programe.cs file.

4 Addto Source Control = &,

3. Since each example in the C# included examples is encapsulated in a separate
class, you can run the examples by uncommenting them (multiple examples
cannot be used simultaneously). For instance, when testing the
Device_GetDevicelnfo example, uncomment it and click run; as shown in the

figure, the device is running normally.
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4 Add to Seurce Cont
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6.3 C# Example Descriptions

6.3.1 Get device information

Device_GetDevicelnfo.cs: Retrieves device information including API version, USB
version, device model, device UID, MCU version, FPGA version, and device

temperature.
6.3.2 Obtain Standard Spectrum Data

SWP_GetSpectrum_Standard.cs: Obtains complete spectrum data within a specified

frequency band.
6.3.3 Obtain 1Q Data for a Fixed Number of Points or Duration

IQS_GetlQdata_Standard.cs: Acquires 1Q data under different trigger modes in 1QS

mode.

6.3.4 Obtain Power Detection Data for a Fixed Number of Points or

Duration

DET_GetPowerTrace_Standard.cs: Obtains power detection data under different

trigger modes in DET mode.

6.3.5 Obtain real-time spectrum data for a fixed number of points or

duration

RTA_GetRealTimeSpectrum_Standard.cs: Retrieves real-time spectrum data under

different trigger modes in RTA mode.

6.3.6 Output single-tone signal

ASG_CWOutput.cs: Devices with signal source functionality options output single-tone
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signals, frequency sweep signals, or power sweep signals through ASG functionality.

6.3.7 AM/FM Demodulation

Demodulation.cs: DSP_FMDemod performs FM demodulation and playback of the
acquired 1Q data. DSP_AMDemod performs AM demodulation and playback of the

acquired 1Q data.

6.3.8 1Qto Spectrum Data

DSP_IQSToSpectrum.cs: Converts the IQ data obtained in IQS mode into spectrum data.

6.3.9 Low-pass filtering

DSP_LPF.cs: Applies low-pass filtering to the acquired IQ data and converts it to

spectrum.

6.3.10 Digital Downconversion

DSP_DDC.cs: Performs digital down-conversion on the acquired 1Q data and converts

it to spectrum.

6.3.11 Phase noise test

DSP_TraceAnalysis_PhaseNoise.cs: Demonstration of Phase Noise Test Function.
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7. Java (to be supplemented)
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8. Labview

8.1 Configure Development Environment

8.1.1 Export library functions from htra_api.dll using LabVIEW

1. Create a folder (e.g., HTRA_Labview) and copy the htra_api folder from the USB
drive located at Windows\HTRA_API\x86 into this folder. Then create another

folder (e.g., VIS) to place the exported vi.

PC » OS(D:) » HTRA_Labview >

Name Date modified Type Size

VIS File folder
|| htra_api.dil Application extens... 1,013 KB
|€] htra_api.h 3/24/2025 8:11 PM C Header Source F... 160 KB

2. LabVIEW does not recognize the uint64_t and int64_t data types during import,
so before importing, all parameters of type uint64_t and int64_t need to be
changed to double. Note that after exporting the functions, these modified

parameter types should be changed back to uint64_t or int64_t in the Vls.

3. Change the encoding format of htra_api.h to UTF-8.
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4.

5.

Open LabVIEW, and select "Tools--->Import--->Shared Library."

£ Labview
File Operate Help

Measurement & Automation Explorer...

Instrumentation

Merge
Security

User Name...

onvert Build Script...

ource Control

LB Manager...

Shared Variable
Distributed System Manager

.NET Controls to Palette... g

ActiveX Controls to Palette...

Shared Library (.dll)...

Find Vs on Disk...

Prepare Example Vis for NI Example Finder...
Remote Panel Connection Manager...

Web Publishing Tool...

| Web Service...

Support
fssion forums or
it

&3 Eind Control and Simulation
" Conne Find LabVIEW Add-ons...
functio
Advanced
Options...

) LabVIEW News |

: |k Welcome to LabVIEW

Leam to use LabVIEW and uparade

from previous versions.

Select "Create VIs for a shared library" and click "Next."

= Import Shared Library

Specify Create or Update Mode I%TEII?JNR#ELNTS E
(O Create Vs for a shared library
Creates Vs based on the header file and shared library file you provide.
() Update Vs for a shared library

Updates previously imported Vis for the following project libraries
Project DLL File Date
saAPLIvlib htra_api.dll 14 /26/2024
saAPLIvlib htra_api.dll 10:17 /25/2024
htra_api.lvlib htra_api.dll 16:59:08 11/21/2023
htra_api.lvlib htra_api.dll 15 11/21/2023
htra_api.lvlib htra_api.dll 15 0 11/21/2023
htra_api.lvlib htra_api.dll 16:21:13 08/25/2023
htra_api.lvlib htra_api.dll 11:36:04 08/25/2023
htra_api.lvlib htra_api.dll 10:26:48 08/25/2023

Back

Cancel

Help

In "Shared Library (.dll) File" and "Header (.h) File", select the corresponding

library files in the previously created folder. After selecting the shared library file

path, the header file path can be automatically recognized and does not need to

be selected again. Then click "Next".
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(ﬂ Import Shared Library X

Select Shared Library and Header File |%TIII?JNHJI‘E|NTS

Shared Library (.dll) File |
DAHTRA_Labview\htra_api.dll ( =

() Shared library file is not on the local machine

Header (.h) File

DAHTRA_Labview\htra_api.h =

{ Back MNext Cancel Help

7. Configure the paths of other dependent files in "Include", which are generally
located in the Visual Studio installation folder, as shown in the path in the figure

below. Then click "Next" and wait for the resolution.

i initi NATIONAL
Configure Include Paths and Preprocessor Definitions INSTRUMENTS
Include X T4

D:\Program Files (x86)\Microsoft Visual Studio\2019\Community\VC\Tools\MSVC\1

ﬂ Parse Header File

Parsing the header file ...

This might take a few minutes. Please wait.

Preprocessor Definitions (use ' to separate multiple preprocessor definitions)

Back MNext Cancel Help

8. Select the functions that need to be exported. Some functions are deprecated or
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not yet open. You can refer to htra_api.h for selection. After selecting, click "Next".

£ Import Shared Library *

i NATIONAL
Select Functions to Convert INSTRUMENTS:

The shared library contains 201 function(s). The declarations of 136 function(s) are found and recognized
in the header file and these function(s) can be wrapped. The remaining function(s) cannot be wrapped. If
you want to import these functions, please review the warning messages next to the functions below. You
will need to fix the problems before you can continue with the wizard.

@ ASD Close ) DSP_GetWindowCoefficient

] ASD_GenerateAMWaveform () void |
] ASD GenerateFMWaveform () DSP_GetWindowCoefficient(unsign

] ASD_GeneratePulseWaveform () fd |0fr;gIW|ndow, long n, double

] ASD_GenerateSignalWaveform () Coefficient);

@ ASD_Open

@ ASG_Configuration ()

B ASG ProfileDelnit

@ DET BusTriggerStart ()
@ DET BusTriggerStop
@ DET EZConfiguration ()
@ DET EZProfileDelnit ()

] DET_SyncTimer )

] DET_SyncTimerByExtTrigger_Single ()
@ DsP_Audiohnalysis ()

@ DSP Close ()

[[J DSP_Convolution ()

@ DSP_DDC_Configuration ()
@ DSP DDC_Delnit

@ DsP_DDC _GetDelay ()

Check all Uncheck All

Back Mext Cancel Help

9. Select the "VIS" folder in the path where the library and header files are stored

for "Project Library Path", then click "Next".

2 import Shared Library X |

i ject Li i NATIONAL
Configure Project Library Settings INSTRUMENTS |

Project Library Name (Ivlib)
htra_api

Project Library Path
DAHTRA_Labview\VIS =4

B Copy the shared library file to the destination directory.

Back Mext Cancel Help
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10. Itis recommended to select "Simple Error Handling" for "Error Handling Mode",

then click "Next".

£} Import Shared Library X

Select Error Handling Mode I%T:I?Jnhféhrs

Error Handling Mode

Simple Error Handling ~

Example Block Diagram

| errar in (na errar)

@

. etror ouk
| Device Number

i [153¥ 1]
i A Return Yalue

Service Channel — 1ii.

cafca
132% Tir|Ti
T3 | 132 Data Cutput
cafea
DMA Channel i
(NEFT, |
|
Dies Words
[132) |
|
Data |
[ua)k

You want to call the generated function only when there are no errors in.

| Back Mext Cancel Help

11. Set the calling library node of each function to "Run in Any Thread". After all

settings are completed, click "Next" and wait for the VI to be generated.
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£} import Shared Library x

i NATIONAL
Configure Vis and Controls INSTRUMENTS:

i F ASD_Close ) Settings  Name and Description
-2 | ASD_Open ()

- | ASG_Configuration ()
- | ASG_ProfileDelnit () VI Execution Properties Preferred Execution System
] DET BusTriggerStart [JJReentrant Execution Same As Caller =

- | DET_BusTriggerStop ()
- | DET_EZConfiguration (
-i | DET_EZProfileDelnit )

- | DSP_AudioAnalysis () Call Library Node Settings
£ ] DSP_Close 0 Thread Calling Convention
-2 | DSP_DDC_Configuration () ORun in Ul thread O stdcall (WINAPI)

2| DSP_DDC Delnit
- | DSP_DDC_GetDelay 0
-2 | DSP_DDC_Reset ()

2] DSP_Decimate ( Declaration in Header File

-i | DSP_FFT_Configuration () - Py |
| DSP_FFT Delnit 0 HTRA_AP| void ASD_Closefvoid*™ AnalogMad); |

¢ | DSP_IFCalibration () |
- | DSP_InterceptSpectrum ()
-: | DSP_LPF_Configuration ()
2| DSP_LPF Delnit { ASD_Clase
-i | DSP_LPF_Execute_Real 0

-2 | DSP_LPF Reset ()
| DSP_NCO Execute {) Call Library Function Node Prototype

-] DSP_Open 0 void ASD_Close{unsigned long *AnalogMod);
-2 | DSP_TraceAnalysis ACPR ()

©Run in any thread Oc

Function Name |

e
[c
£
£
[c
£
£
[c
£
£
£
£
£
£
£
£
£
£
£
£
£
[£
£
£
[£

Back Next Cancel Help

12. Check "Open the generated library". "View the report" is optional. Click "Finish".

ER import Shared Library x

- NATIONAL
Finish INSTRUMENTS

B Open the generated library

(O view the report (Errors occurred during the processing, please view the report for more information.

)

Back Cancel Help

13. The Vis in the "VIS" folder are the exported API functions. This concludes the

process of exporting the API functions.
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ThisPC > Data(D:) » HTRA Labview > VIS »

Tl Sert -

Name
@ ASD Close.wvi
[l ASD Demodulate AM.vi
[, ASD Demodulate FM.vi
[l ASD Openwvi
@ ASG Cenfiguration.vi
[l ASG Profile De Init.vi
=l DETBus Trigger Start.wi
=) DETBus Trigger Stop.vi
@ DET Cenfiguration.vi
@ DET Get Power Stream.vi
[l DET Profile De Init.i
@ Device Close.vi
=l Device Open.vi

B Device Query Device State Realtime.vi

View ~ e

Date modified

11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM
11/15/2024 10:35 AM

11/15/2024 10:35 AM

Vs

Type

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

LabVIEW Instrume...

Size

Search Vls =

(D Preview

S KB
23 KB
24 KB

KB
15KB
12KB

S KB

KB
26 KB
19 KB
20 KB

KB
15 KB

13 KB
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8.1.2 Using the APl in the LabVIEW environment

1.

2.

3.

Open LabVIEW and click "Create Project."

| R LabVIEW — (] *

File Operate Tools Help

| ERLabVIEW ( D
' (/_D) Open Existing |

| | Al Recert Files -
htra_api Ivib
T -
| D] Create Project
~ Find Drivers and Add-ons »/| Community and Support b/ Welcome to LabVIEW
Connect to devices and expand the ~ Participate in the discussion forums or " Leamtouse LsbVIEW and upgrade
functionality of LabVIEW request technical support from previous versions.

£) LabVIEW News |

Select "Blank Project" and click "Finish."

| £} Create Project (m] >
|
| Choose a starting peint for the project:

All Blank Project 7emplates
Templates ?E ! Creates a blank project
Sample Projects

Blank ¥I Templates
g;! Creste /

sections of code. Mere Information

Facilitatzs defining the exscution sequence f

é’;) Siaple State Nachine 7emplazes

Queued Nessage Handler Tespliztes
30 Faciitates muttiple sections of code wnn ing in parallel and sending data between them. Mere Infermation

e, nt tasks that co
Mere Infermation

N Finite Neasurement Szmple Projecis

wanasa’| options for exporting th
zte. Mere Information

Continuous Heasurement and Logging sample Projecis

ty and logs them to disk. This sample project is based on the Queusd

e
) ¢

Feedback Evaporative Cooler Sampie Projecis

with hot-swappable hardware, contrallers, and user interfaces. This sample project is

ste Mare Information

Instrument Driver Project Templares

Torwinkh Domal Dmn fmnd 7o loao_

Additional Search

Finish Cancel Help

An unnamed empty project will then appear. Save the project with "Ctrl+S", select

the project save path and name the project, then click "OK".
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B Untitled Project 1 - Project Explorer O
File Edit View Project Operate Tools Window Help

K Y= I ‘JJbi‘fﬁ\E‘E'?"|jJ “j | ‘

ltems  Files

= [ | Project: Untitled Project 1
&

i- &' Dependencies
'Lf:‘ Build Specifications

Name the Project (Untitled Project 1) X
&« o <« Data(D:) » HTRA_Labview_Demo ~ &) Search HTRA Labview_Demo 0
Organize = New folder = - (7]

A~
> & Name ~ Date modified Type Size
> ik Acer (C) No items match your search.
> == Data (D:)
> & Network
File name: IHTRA_Labview_Examples W
Save as type: Projects (*.lvproj) v

A Hide Folders Cancel

Copy the "htra_api" folder from the "\Windows\HTRA_API\x86" directory on the
USB flash drive to the same directory level as this project. Additionally, you can
create an "Examples" folder to store examples. If needed, you can also create

another folder, such as "Subvi", to store sub-ViIs.

ThisPC > Data(Dj) > HTRA Labview Demo > Search HTRA_Labview_Demo q
Tl Sort = View aee (1) Previe
Mame Date medified Type Size
Examples File folder
htra_api File folder
Subvi File folder
D HTRA_Lzbview_Examples.aliases ALIASES File 1KB
D HTRA_Labview_Examples.lvips LVLPS File TKB
|7_=£1, HTRA_Labview_Examples.lvproj LabVIEW Project 2KB

Copy the previously exported library functions, i.e., the contents of the "VIS"

folder created in section 8.1.1, to the "htra_api" folder.
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PC > OS(D:) > HTRA_Labview_ Demo > htra_api

~

Name Date modified Type Size
CalFile 5/9/2025 5.05 PM File folder
Vis 5/14/2025 2:19 PM File folder
B htra_api.dll 3/24/2025 3:46 PM Application extens... 1,013 KB
htra_api.h 3/24/2025 8:11 PM C Header Source F... 160 KB
B hira_apilib 3/24/2025 3:46 PM Object File Library 53 KB
3 hra_apilvlib 11/17/2024 11:42 PM LabVIEW Library 8 KB
htra_api_pnm.h 3/25/2025 9:42 AM C Header Source F... 8KB
libgee_s_dw2-1.dll 1/12/2024 837 AM Application extens... 123 KB
libiomp5md.dll 4/30/2024 3:30 AM Application extens. 1,900 KB
libliquid.dll 1/12/2024 8:37 AM Application extens... 1,743 KB
i libliquid.lib 1/12/2024 8:37 AM Object File Library 1,618 KB
libmkl.dil 4/30/2024 2:30 AM Application extens... 42,043 KB
EE libmkl.lib 4/30/2024 3:30 AM Object File Library 6 KB
| libwinpthread-1.dll 1/12/2024 8:37 AM Application extens... 67 KB
liquid.h 1/12/2024 837 AM C Header Source F... 431 KB
mkl_dfti.h 4/30/2024 2:30 AM C Header Source F... 11KB
mkl_service.h 4/30/2024 3:30 AM C Header Source F... 8 KB
mkl_types.n 4/30/2024 3:30 AM C Header Source F... 5KB
vcomp140.dIl 5/10/2023 7:02 AM Application extens... 159 KB
veruntime140.dll 2/1/2002 6:02 PM Application extens... 90 KB

6. Inthe LabVIEW project, add the newly created Examples folder and the htra_api

folder to the project, and then save.

B} HTRA_Lsbview_Examples.lvproj * - Project Explorer = ] X
File Edit View Project Operate Tools Window Help
IEEEIE e | - o] o

Items  Files

File...
Folder (Snapshot]...
Folder {Auto-populating)...

Find Project ltems...

Arrange By

Hyperlink...

Expand All
= [B. Project: HTRA Labview Examples.vproj
Collapse All - -
2 B My Computer
A
Help...
Properties
Dependencies

‘é Build Specifications

7. Create a new Vlin the "Examples" folder. You can then call the exported LabVIEW
API functions within the block diagram. The calling process is consistent with that

in the C environment.
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8.

HTRA_Labview_Examples.vproj - Project Explorer

File Edit View Project Operate Tools Window Help
sl xbox|isk @-@Eallanellogn|n]
Items  Files

E &l Project: HTRA_Labview Examples.vproj
- My Computer

[@ hira_api

[ Delpende Explore... Control
" # Build Sp Show in Files View Ctrl+E Library
Aadd 5 Variable
Class
Stop Auto-populating XControl
Items incorrectly claimed by a library
Arrange By 3

Remove from Project

Finally, save this program to the Examples folder and rename it.

Save as type: Vls (*.vi;*vit)

A Hide Folders

New LLB...

£2 Name the VI (Untitled 1) X
<« > v 4 - «i HTRA_Labview_Demo > Examples | v C Search Examples P
Organize v New folder = - o
Name Date modified Type Size
v - This PC No items match your search.
> 4 WPS
> Ba Acer (<)
> we Data (D)
> t Network
File name: I SWP_Example v

Cancel
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8.1.3 Use the newly exported library functions in an existing project.

The following uses the library function DSP_InterceptSpectrum() as an example to

illustrate how to use newly imported functions within an existing project.

1. For the method of exporting library functions, please refer to section 8.1.1. Note
that in the popped-up htra_api.lvlib, you should delete the exported functions
and DLL files from the project, and then close htra_api.lvlib, as shown in the figure

below.

B} htra_apiviib on Main Application Instance = [m] x
File Edit VYiew Project Operate Tools Window Help

ltems  Files

=8 |__; htra_api.hviib

> gﬂ DSP Intercept Spectrum Open
B hira_api.dll
Print...
Remove from Project

2. Copy the exported DSP_InterceptSpectrum function VI to the htra_api\VIs folder

of the existing project.
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= m} X
ackup ¥ HTRA_Labview_Examples Folder (1) > htra_api > Vis Search Vs Q
| = imj Tl Sort = View “ee (D Preview
Name - Date modified Type Size
Ei, DSP Generate Sine Waveform.vi 11/15/2024 10:38 AM LabVIEW Instrume... 15 KB
|§§. DSP Get White Gaussian MNoisewvi LabVIEW Instrume... 13 KB
|;§, DSP Get Window Coefficient.vi LabVIEW Instrume... 15 KB
|;§1 DSP IF Calibration.vi 11/15/2024 10:38 AM LabVIEW Instrume... 14 KB
I|§§. DSP Intercept Spectrum.vi 11/19/2024 4:28 PM LabVIEW Instrume... 13KB
|;§, DSP LPF Cenfiguration.vi 11/17/2024 10:03 PM LabVIEW Instrume... 13 KB
[#) DSP LPF De Initwi 11/17/2024 10:03 PM LabVIEW Instrume... 12KB
|g§, DSP LPF Execute Complex.vi 11/18/2024 11:14 AM LabVIEW Instrume... 48 KB
|g’;, DSP LPF Execute Real.vi 11/15/2024 10:38 AM LabVIEW Instrume... 15 KB
%) DSP LPF Resetui 11/15/2024 10:38 AM LabVIEW Instrume... 13KB
|g§, DSP Open.vi 11/17/2024 8:46 PM LabVIEW Instrume... 11KB

3.

htra_api.lvlib within the project.

R HTRA_Labview_Examples.lvproj - Project Explarer
| File FEdit View Project Operate Tools Window Help

oS xm o X[[Ek me [

Open the project with LabVIEW, then open the htra_api\Vis folder and

| Items  Files

= E; Project: HTRA_Labview_Examples.lvproj

DSP Intercept Spectrum.vi

- [%] htra_api.dil
- € htra_api.h

B htra_api.lib
r— ; htra_api.lvlib
ASD Closewi
ASD Demodulate AM.vi
ASD Demodulate FM.vi
ASD Openwi
ASG Configuration.vi
ASG Profile De Initwi
DET Bus Trigger Start.vi
DET Bus Trigger Stop.vi
DET Configuration.vi
DET Get Power Stream.vi
DET GetTracewi
DET Profile De Initavi
Device Closewi

e
o el

Device Generate Linear IF Calibration.vi
Device Get DOCXO Work Mode.vi

4. Drag the DSP_InterceptSpectrum function VI

from the VIs folder into

htra_api.lvlib. At this point, you can use the newly added VI function normally.
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= By Project: HTRA_Labview_Examples.lvproj

B B MyC
B Ex

]
-8

HER

-[3 htra_api
]

T (AL AL )

A [ (AL AL

omputer
ample

CalFile

Vis

htra_api.dll

htra_apih

hira_apilib

htra_apiviib

ASD Closewi

ASD Demedulate AM.vi

45D Demedulate FM.vi
45D Openai

ASG Configuration.vi
456 Prefile De Initvi
DET Bus Trigger Start.vi
DET Bus Trigger Stop.vi
DET Configuration vi
DET Get Power Stream.vi
DET GetTrace i

DET Profile De Initwvi
Device Close.vi
Device Open.vi

Device Query Device Info.vi

Device Query Device Statewi

DSP Audio Analysis.vi

DSP Close.vi

DSP DDC Configurationvi

DSP DDC De Initvi

DSP DDC Executeni

DSP DDC Get Delay.vi

DSP FFT Configuration.vi

DSP FFT De Init.

DSP FFTIQS To
rcept

[ DSP LPF De Init.vi

Device Query Device Info Realtime.vi

Device Query Device State Realtime.vi

HTRA API Example Usage Guide 85



8.1.4 Generate an exe from the vi in Labview

The following uses the LabVIEW project located in the \Windows\HTRA_AP|_Example
folder on the USB flash drive as an example to illustrate how to build a program VI into
an executable (.exe) file.

1. Open the LabVIEW project, then select "Build Specifications --> New -->

Application (EXE)".

% HTRA_Lsbview_Examples.lvproj - Project Explarer = [m] x
File Edit View Project Operate Tools Window Help
[EEEIE &6 - oo | o]

l Items  Files

= &l Project: HTRA_Labview_Examples.vproj
B Q My Computer
& [@ Example
- [@ htra api

| B _‘Q Dependencies
'Y Build Specification - -

Installer

.NET Interop Assembly
Find Project ltems... Packed Library
Shared Library (DLL)

Build All

Arrange By »

| Expand All Source Distribution
Collapse All Zip File
Help...

2. Fillin the standard name of the program file generated, the name of the exe, and

the target directory path in "Information".

HTRA APl Example Usage Guide 86



E’ SWP_Example Properties *

Source Files Build specification name
Comce i
SWP_Exampl
Source File Settings —XAmPE
lcon Target filename
Additional Exclusions
Version Information Destination directory
Windows Security Ci\Users\ 15335\ Desktop\D.55.52\Windows\HTRA_AP|_Example\HTRA_Labview_Examples\bin =
Shared Variable Deployment - -
Run-Time Languages
Web Services
Pre/Post Build Actions Build specification description
Preview

Build QK Cancel Help

3. Select the vi programs, CalFile folder, and all dependent library files to be

exported as exe in "Source Files".

jﬂ' SWP_Examples Properties *x
Information
Source Project Files Startup Vs
Destinations =8 =l SWP_Example.vi
Source File Settings 5+ Example
lcon i ilml DET Examplevi
Advanced i = 105 Examplewi
Additional Exclusions i lml RTA Examplevi b
Version Information [ =
Windows Security = htra_api
Shared Variable Deployment
Run-Time Languages - Vls
Web Services -
|| Pre/Post Build Actions - €] htra_api.h
Preview -BB8 htra_api.lib
{3 htra_api.lvlib Always Included
-[8) CalFile
-2 [2] htra_api.dll
-2 [ libgce_s_dwz-1.dl
-8l libliquid.lib [ libiompSmd.dll
B = -[3) libliquid.dll
BUE libmkd.lib e - [%) libmkd.dll
5] - [3] libwinpthread-1.dll
<l liguidh
| mkl_dftih
- € mkl_service.h
- € mhl tvpes.h
Build OK Cancel Help

4. Add alayer of htra_api to the target path of "Support Directory" in "Destinations"

to store the libraries and calibration folder.
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E’ SWP_Example Properties

Category

Information

Source File Settings
lcon

Advanced

Additional Exclusions
Version Infarmation
Windows Security
Shared Variable Deployment
Run-Time Languages
Web Services
Pre/Post Build Actions
Preview

‘ Destinations

SWP.exe

Support Directory|

inations

Destination label

Support Directory

Destination path

C\Usersi15335\Desktopy0.35.52\Windows\ =
HTRA_API_Example\HTRA_Labview_Examples'
bin\htra_api

Destination type
© Directory
Preserve disk hierarchy
LLE

() Add files to new project library

Library name

Build QK Cancel Help

5. Add a CalFile folder to store the device's calibration files, and add the target path

of CalFile to the directory under "Support Directory".

E’ SWP_Example Properties

Category

Information
Source Files

ource File Settings
lcon
Advanced
Additional Exclusions
Version Information
Windows Security
Shared Variable Deployment
Run-Time Languages
Weh Services
Pre/Post Build Actions
Preview

Destinations

SWP.exe

nations

Destination label
CalFile

Destination path
C\Users\15335\Desktopl0.53.52\Windows\, =
HTRA_API_Example\HTRA_Labview_Examples\
bin\htra_api\CalFile

Destination type

© Directory
[ Preserve disk hierarchy

Ous

[T Add files te new project library

Library name

Build oK Cancel Help

6. In"Source Files Settings", select the target path of the calibration files to "CalFile".
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E’ SWP_Example Properties

Category

Information
Source Files

con

Advanced

Additional Exclusions
Version Infarmation
Windows Security

Shared Variable Deployment
Run-Time Languages

Web Services

Pre/Post Build Actions
Preview

Project Files
=8
_ Example
=]

c| htra_api.h
-8 htra_api.lib

libgce_s_dw2-1.dll

libiomp3md.dil

libliquid.dil

-BHE libliquid.lib

libmkl.dll

B libmkl.lib

~|%| libwinpthread-1.dll
| liguid.h
| mkl_dfti.h

- € mkl_service.h

=

-5 D

mkl_types.h
-5 Dependencies

Inclusion Type
Always Included

8 Set destination for all contained items
CalFile ~

() Set VI properties for all contained items
Customize VI Properties...
[T Set save settings for all contained items
Use default save settings
() Remove front panel
Remove block diagram
[T Set password for all contained items

© No password change
(7 Remove password
() Apply new password

() Apply prefix to all contained items

Build QK Cancel Help

7. Select the target paths of all dependent libraries to the "Support Directory".

£8 swp_Example Properties

Category

Information
Source Files
Destinations

con
Advanced

Additional Exclusions
Version Information
Windows Security

Shared Variable Deployment
Run-Time Languages

Weh Services

Pre/Post Build Actions
Preview

Project Files
=8
G Example
é _ htra_api
~ CalFile
Ch
- € htra_api.h
-8 htra_api.lib

libgce_s_dw2-1.dll
libiomp3md.dll

libliquid.dll
libliguid.lib

libmkLlib
- € liquid.h
- € mkl_dfti.h
c| mkl_service.h
- € mkl_types.h
-5 Dependencies

Inclusion Type
Always Included

Destination

Support Directory ~

Customize VI Properties...

(") Use default save settings
("] Remove front panel

|_JRemove block diagram

© No password change
() Remove password
) Apply new password

[CJ Rename this file in the build
htra_api.dll

Build oK Cancel Help

8.  Click "Build".
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2 SWP_Examples Properties

,X .

Information
Source Files Project Files Inclusion Type
| | Destinations =8 Always Included
Erampl >
H X Destination
| | lcon 27 htra_api
| | Advanced CalFile Support Directory V
; Additional Exclusions -1 Vls
Version Information AR hira api.dll
ko , [
Windows Security €| htra_api.h
Shared Variable Deployment 89 htra_apilib
| Run-T\me.Languages ' htra_api‘\v\ib Customize VI Properties...
Web Services [3] libgee s_dw2-1.dll
Pre/Post Build Actions ~[4] libiompSmd.dll
Preview ] libliquid.dll (ockEd sevmaifs
‘ -8 libliguid.lib Remove front panel
-3 Ifbmkl.cliH Remove block diagram
--BHE libmkl.lib
[2] libwinpthread-1.dIl
< liquidh © No password change
- /c] mkl dfti.h Remove password
- €] mkl service.h Apply new password
- ] mkl_types.h
= Dependencies
[ Rename this file in the build
htra_api.dll
oK Cancel Help

9. At this point, the generation of the exe program from the vi program in Labview
is complete.

up > Desktop > 05552 > Windows > HTRAAPLExample > HTRA_Labview_Examples > bin >

M Sort = View
Name - Date modified Trpe Size
[] swr.aliases ALIASES File 1kB
SWP.exe Application 268 KB
,L‘-_'I SWP.ini J/2024 8:37 PM Configuration sett... 1KB

CalFile
[3) htra_apidil

(3] libgee_s_dw2-1.dil
[3 libiempSmd.dil
[ libligquid.dii

(3] Hibmk.an

[5] tibwinpthrezd-1.d1

8.2 The usage process of Labview examples

The usage process of Labview examples included in the USB drive is as follows:

1. Open the the folder

accompanying USB drive using LabVIEW in
Windows\HTRA_API_Example\HTRA Labview Examples, and open the project

HTRA_Labview_Examples.lvproj.
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) > USBDrive(F) > | Windows > HTRA_AP|_Example > HTRA Labview Fxamples >|

Tl Sort ~ = View ~ e
Name - Date modified Type Size

Example 1/9/2025 3:17 PM File folder
htra_api 1/9/2025 3:48 PM File folder
VI 1/9/2025 3:17 PM File folder

D HTRA_Labview_Examples.aliases 11/29/2024 6:09 PM ALIASES File 1KB

D HTRA_Labview_Examples.Ivips 11/29/2024 6:09 PM LVLPS File 2 KB

I L] HTRA_Labview_Examples.lvproj I 11/29/2024 6:09 PM LabVIEW Project 28 KB

2. After opening the project, double-click to open any routine vi in the Example
folder. For example, here we open SWP_GetSpectrum_Standard.vi to use the

SWP mode routine.

£ HTRA_Labview_Examples.lvproj - Project Explorer - m] X
| File Edit View Project Operate Tools Window Help

I IR |85 W | B~ o] o

Items  Files

= Bl Project: HTRA Labview Examples.lvproj
5E A -

. ASG_CWOutput.vi

. DET_GetPowerTracewi

. Device_GetDevicelnfo.vi

. DSP_AudioAnalysis.vi
DSP_DDC.vi

+ DSP_IQSToSpectrum.vi
1QS_GetlQ_FixedPoints.vi
1QS_RecordAndPlayback.vi
._RTA GetRealTimeSpectrum.vi

. SWP GetSpectrum Standard.vi I

tra_api

B O L AL

o

T
.

=

Dependencies
- #®. Build Specifications

3. Once the program is opened, simply click the run button in the upper left corner,

as shown in the image where the program is running normally.
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SWP_GetSpectrum.

Fle Edit View Project Operate Tools dow Help
@n
Model My £PGA Al
SAE9O_R3 05540 05515 V05555
Us8_Port PowerSpec_dBm out Frequency out
o UL FrerTTy g0 Jaa0k
BootProfie Sl xv =0 IR Proficon
Pyicliniacace Strtfreq Hz M|
soss | o000 Qsearch
DevicePowerSupply 4
ittt S ¥ Modern —_
S s . —
ETH iP¥ersion e = Yo =
s = | 20|
Lol Neocn ] Numeric  Boolean  String & Path
ETH_IPAddress(0] 2 7 &
B m =
ETH 1PAddress{1] ListTable &.  Graph
168 " L LJ@" B
ETH_IPAddress(2] _}a
' Ring & Enum  Containers. /0 -
P o ¥ o B
ETH_IPAddress(3] o 83 B
' Varisnt & C.. Decorations  Refrum | |

IPAddress[4]

: J

«/StartStop

Window

T

RA Labview Examples.vproi/My Computer]

RBW Mode

> Silver

» System
» Classic
» Express
P NET & ActiveX

Select a Control.

[JRRE——S-.
] RBW_Mode
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8.3 Labview Example Description

8.3.1 Get device information

Device_GetDevicelnfo.vi: An example for obtaining various device information,
including: API version, device model, device UID, MCU version, FPGA version, and

device temperature.
8.3.2 Standard spectrum acquisition

SWP_GetSpectrum_Standard.vi: Obtains standard spectrum data within a specified

frequency band and displays the image.
8.3.3 Obtain IQ Data for a Fixed Number of Points or Duration

IQS_GetlQ_FixedPoints.vi: Obtains IQ data with a fixed number of points. When the

device receives a Bus trigger signal, it returns 1Q data with a fixed number of points.

8.3.4 Streaming and reading IQ data

IQS_RecordAndPlayback.vi: Obtains |Q data, records the |Q data as a txt file, and plays

back the recorded IQ data.

8.3.5 1Qto Spectrum Data

DSP_IQSToSpectrum.vi: Obtains 1Q data and converts the acquired 1Q data into

spectrum data.

8.3.6 Digital Downconversion

DSP_DDC.vi: Performs digital downconversion on the IQ data stream and resamples to

generate a sub-1Q stream for further spectrum analysis.
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8.3.7 Audio Analysis

DSP_AudioAnalysis.vi: Analyzes audio voltage (V), audio frequency (Hz), signal-to-

noise ratio (dB), and total harmonic distortion (%).

8.3.8 Obtain Power Detection Data for a Fixed Number of Points or

Duration

DET_GetPowerTrace.vi: Obtain a fixed number of DET data points. When the device

receives a Bus trigger signal, it returns a fixed number of DET data points.

8.3.9 Obtain real-time spectrum data for a fixed number of points or

duration

RTA_GetRealTimeSpectrum.vi: Obtain a fixed number of RTA data points. When the

device receives a Bus trigger signal, it returns a fixed number of RTA data points.

8.3.10 ASG Signal Source Output Signal

ASG_CWOutput.vi: Control the internal signal generator of the device to output single-

tone signals, sweep signals, and power scan signals.
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9. Linux

9.1 Environment Version Compatibility Self-Check

When using the device in a Linux system, you first need to confirm whether the current

Linux environment's system architecture, gcc version, and GLIBC version are supported

according to the following process:

1. Open the terminal and enter "uname -a" to check the Linux system architecture,
for example, here the Linux system architecture is x86_64.

2. Inthe terminal, enter "gcc -v" to check the system gcc version, for example, here
the gcc version is 7.5.0.

3. In the terminal, enter "ldd --version" to check the system GLIBC version, for

example, here the GLIBC version is 2.27.

htra@ubuntu: ~

File Edit View Search Terminal Help
htra@ubuntu:~$ uname -a
Linux ubuntu 5.4.8-150-generic #167~18.084.1-Ubuntu SMP Wed May 24 00:51:42 UTC 2023 x86_64 Xx86_64 x86_64 GNU/Linux
htra@ubuntu:~5 gcc -v
Using built-in specs.
COLLECT_GCC=gcc
COLLECT_LTO_WRAPPER=/usr/lib/gcc/x86_64-1inux-gnu/7/1lto-wrapper
OFFLOAD_TARGET_NAMES=nvptx-none
OFFLOAD_TARGET_DEFAULT=1
Target: x86_64-1linux-gnu
Configured with: ../src/configure -v --with-pkgversion='Ubuntu 7.5.0-3ubuntul~18.04" --with-bugurl=file:///usr/share/doc/gcc-7/
--enable-languag ada,c++,go,brig,d,fortran,objc,obj-c++ --prefix=/us h-gcc-major-version-only --program-s
--program-prefi 8 linux-gnu- --enable-shared --enable-linker-build-i xecdir=/usr/1lib --without-included-g
--enable-threa ibdir=/usr/1ib --enable-nls --enable-bootstrap --enable-clocale=gnu --enable-libstdcxx-debug -
-enable-libstdcxx-time=y - -default-1libstdcxx-abi=new --enable-gnu-unique-object --disable-vtable-verify --enable-libmpx
--enable-plugin --enable-default-pie --with-syste 1ib --with-target-system-z1lib --enable-objc-gc=auto --enable-multiarch --di
sable-werror --with-arch-32=1686 --with-abi=mé64 --with-multilib-list=m32,m64,mx32 --enable-multilib --with-tune=generic --enabl
e-offload-targets=nvptx-none --without-cuda-driver --enable-checking=release --build=x86_64-1linux-gnu --host=x86_64-1linux-gnu -
-target=x86_64-1linux-gnu
Thread model: posix
gcc version 7.5.0 (Ubuntu 7.5.0-3ubuntul~18.04)
htra@ubuntu:~$ 1dd --version
1dd (Ubuntu GLIBC 2.27-3ubuntul.6) 2.27
Copyright (C) 2018 Free Software Foundation, Inc.
This is free software; see the source for copying conditions. There is NO
warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
Written by Roland McGrath and Ulrich Drepper.
htra@ubuntu:~$

4. Confirm whether the current environment is supported according to the terminal
information comparison table. If it is not yet supported, please contact technical

support personnel.

X86 processor Support Intel and AMD processors

ARM processor aarch64 (armv8), armv7 processors, such as: Raspberry Pi 4b, RK3399,

RK3568, RK3588, T507, NVIDIA Jetson TX2

Compilation gccd.8, glib2.17 and above
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environment

Distribution

Customized system for Raspberry Pi 4b, Ubuntu 18.04, etc.
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9.2 Accompanying documentation

Currently, the Linux section of the accompanying USB drive contains the following

materials:

9.2.1 HTRA_C++ _Examples

The HTRA_C++_Examples folder contains:

1. Examples folder: C++ example programs (see Chapter9.4 for usage).

2.  Makefile: A build script used to compile the example programs into executable
files.

3. bin folder: Used to store device calibration files and executable files generated

from the example programs.

> USBDrive (F) > Linux > | HTRA_C++_Examp|es| > Search HTRA_C++_Examples
T Sort = View v
Name B Date modified Type Size
bin 12/11/2024 5:36 PM File folder
Examples 12/11/2024 5:36 PM File folder
D Makefile 4/30/2024 3:30 AM File 1 KB
|=| README.txt 4/30/2024 3:30 AM Text Document 1KB

9.2.2 HTRA_Qt_Examples

The HTRA_Qt_Examples folder contains:

1. htrademo folder: Qt examples and pro files (see Chapter9.5 for usage).

2. bin folder: Used to store device calibration files and executable files compiled
from the example programs.

3. htraapi folder: Used to store dynamic link libraries.
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> USBDrive (F) > |Linux >

HTRA_Qt Examples | >

Search HTRA_Qt_Examples

N Sort = View ~ see
~
Name Date modified Type Size
bin 12/11/2024 5:36 PM File folder
htraapi 12/11/2024 5:36 PM File folder
htrademo 12/11/2024 5:36 PM File folder
E| README.txt 5/10/2024 2:32 AM Text Document 1KB

9.2.3 HTRA_Python_Examples

HTRA_Python_Examples folder specifically contains:
1. Python example programs (see Chapter9.6 for usage).
2. CalFile folder: stores device calibration files.

3. Htraapi folder: used to store dynamic link libraries.

O > USBDrive(F) > | Linux > HTRA Python Examples > | See
] T Sort ~ = View ~ e
~
Name Date modified Size
CalFile 1/8/2025 411 PM
htraapi 1/8/2025 411 PM
[ ASG_CWOutput.py 1/8/2025 11:00 AM 4 KB
@ DET_GetPowerTrace_Standard py 1/8/2025 10:43 AM 6 KB

9.2.4 HTRA _Gnuradio

The HTRA_Gnuradio folder contains two adaptation for GNU Radio:

1. The HTRA OOT method.

2. The SoapySDR adaptation method.

(J > ESD-USB(E) > Linux > |HTRA Gnuradio Fxamples >
Tl Sort ~ = View “es
Name Date modified Type Size
HTRA OCT 2025/8/7 15:34 File folder
HTRA SoapySDR 2025/8/7 15:34 File folder
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9.2.5 Install_HTRA_SDK

Install_HTRA_SDK folder contains:

1.

2.

install_htraapi_lib.sh: driver configuration script.
Install_HTRA_SDK\htraapi\configs folder: driver configuration files.
Install_HTRA_SDK\htraapi\inc folder: header files.
Install_HTRA_SDK\htraapi\lib\arrch64 folder: arrch64 architecture dynamic link
libraries.

Install_HTRA_SDK\htraapi\lib\arrch64 gcc7.5 folder: Dynamic link library for
arrch64 architecture with more efficient FFT (requires system gcc version higher
than 7.5).

Install_HTRA_SDK\htraapi\lib\x86_64 folder: Dynamic link library for x86_64
architecture.

Install_HTRA_SDK\htraapi\lib\x86_64_gcc5.4 folder: Dynamic link library for
x86_64 architecture with more efficient FFT (requires system gcc version higher
than 5.4).

Install_HTRA_SDK\htraapi\lib\armv7 folder: Dynamic link library for armv7

architecture.

J > USBDrive(F) > Linux > |Install HTRA SDK |> Search Ins

T Sort ~ = View
Name . Date modified Size
htraapi 1/7/2025 11:18 AM
B install_htraapi_lib.sh 4/30/2024 3:30 AM 3KB
= README.txt 4/30/2024 3:30 AM 1KB
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> USBDrive(F) > Linux > Instal_ HTRA_SDK >|htraapi > lib |> Search lib

Name

_ aarchbt4

aarch®4_gec?.5
armvy
x86_64

x86_64_gcc5.4

Tl sort ~

View ~ saa

Date modified

12/11/2024 5:36 PM
12/11/2024 5:36 PM
12/11/2024 5:36 PM
12/11/2024 5:36 PM

12/11/2024 5:36 PM

Type Size
File folder
File folder
File folder
File folder

File folder
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9.3 Driver file configuration

To use the device in Linux, the driver file must be configured first. The specific process

is as follows:

1. Driver file configuration: First, drag the Install_HTRA_SDK folder into the Linux
host computer, then open a terminal in the Install_HTRA_SDK folder and enter
"sudo sh install_htraapi_lib.sh" to configure the driver file. If the special
development board does not have the sudo command, simply enter "sh

install_htraapi_lib.sh".

htra@ubuntu: ~/Desktop/Linux/install HTRA_SDK
h Terminal Help

[%]3.192.168.1.100 (root)

term 20.6

(SSH client, X-server and networking tools)

» SSH session to t@:
? SSH compression : v«
? SSH-browser R
? X11-forwarding : by server)
? DISPLAY s

> For more 1

root@forlinx:~# cd test

root@forlinx:~/test# cd Linux/

root@forlinx:~/test/Linux# cd Install HTRA_SDK/
root@forlinx:~/test/Linux/Install HTRA SDK# sh install_htraapi_lib.sh
root@forlinx:~/test/Linux/Install_HTRA SDK# [

2. Configuration check: Ensure the device is correctly connected to the host
computer (if the host computer is a virtual machine, ensure the device is
connected to the virtual machine and that USB compatibility is 3.1) and provide
normal power to the device. At this point, as shown in the figure, enter "Isusb" in
the terminal to view the list of USB devices on the machine, where "ID: 6430 (or

ID: 3675 or ID: 04b5)" indicates successful device connection.
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File

htra@ubunku: ~

Edit View Search Terminal

htra@ubuntu:~5% lsusb

Bus
Bus
Bus
Bus
Bus
Bus

004 Device 002: ID 367f:

004 Device 001: ID 1dé6b: Linux Foundation 3.0 root hub

003 Device 001: ID 1d6b:0002 Linux Foundation 2.0 root hub

001 Device 001: ID 1dé6b: Linux Foundation 2.0 root hub

002 Device 003: ID OeOf: VMware, Inc. Virtual USB Hub

002 Device 002: ID OeOf: VMware, Inc. Virtual Mouse
Device 001: ID 1d6b: Linux Foundation 1.1 root hub

9.4 C++ example usage and project creation

9.4.1 C++ example usage

Under the premise that the device is properly connected and the driver files have been

correctly configured as per Chapter9.3, if you wish to use the C++ examples included

on the USB drive, you can refer to the following process (the specific functions of the

examples can be directly viewed in the description in Chapter 1):

1.

Select the program to compile: First, copy the Linux\ HTRA_C++_Examples folder
from the USB drive to the host computer. Double-click to open main.cpp in the
Examples folder, and uncomment the example you need to test (the following
steps will take the SWP_GetSpectrum_Standard example as an example), as

shown in the figure to uncomment.

main.cpp

int

{

Makefile x main.cpp *

#include "example.h"

main()
int Status = 8;

//Status = Device_GetDeviceInfo();
//Status = Device_SysPowerState();

Status = SWP GetSpectrum Standard();
Status = SWP_EZGetPartialSweep();

J/Status = SWP_MaxHold_MinHold();
//Status = SWP_TraceAverage():
//Status = SWP_AutoSetMeasure();
f//Status = SWP_SetFreqCompensation();
//Status = SWP PickMaxPower():

Refer to the system architecture in Chapter9.1, and based on the selected test
example, open the terminal in the HTRA_C++_Examples folder, following the host

computer's system architecture.
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1) For x86_86 system, input:
(the example routine here is SWP_GetSpectrum_Standard)
make Example=SWP_GetSpectrum_Standard
2) For aarch64 system, input:
make TARG=aarch64 Example=SWP_GetSpectrum_Standard
3) For armv7 system, input:

make TARG=armv7 Example=SWP_GetSpectrum_Standard
htra@ubuntu: ~/Desktop/1/HTRA_C++ Examples
File Edit View Search Terminal Help

tra@ubuntu: S make Example=SWP_GetSpectrum_Standard

g++ -0 bin/SWP_GetSpectrum_Standard Examples/SWP_GetSpectrum_Standard.cpp Exampl
es/main.cpp Examples/Error_handling.cpp -std=c++11 -Ifopt/htraapi/inc -L/opt/htr
gapi/lib/x86 64 -lhtraapi -Wl,-rpath='/opt/htraapi/lib/x86 64"

tra@ubuntu: s i

=

3. Verify the calibration file: Open the HTRA_C++_Examples\bin\CalFile folder, and

ensure that the folder contains the device calibration files, as shown in the figure.

1 Desktop Linux = HTRA C++ Examples bin CalFile

Recent

Home

023_ 023_

Desktop 4248500b0  4248500b0
00b0036_  00b0036_
Documents ifacal.txt rfacal.txt

Downloads

4. Run the program: After the program compiles successfully and the calibration is
confirmed to be correct, open the terminal and input:

./bin/SWP_GetSpectrum_Standard

The example shown in the figure is a normal operation example.

htra@ubuntu: ~/Desktop/1/HTRA_C++_Examples
File Edit View Search Terminal Help

htra@ubuntu: $ make Example=SWP_GetSpectrum_Standard
g++ -0 bin/SWP_GetSpectrum_Standard Examples/SWP_GetSpectrum_Standard.cpp Exampl

es/main.cpp Examples/Error_handling.cpp -std=c++11 -Ifopt/htraapi/inc -L/opt/htr
aapi/lib/x86_64 -lhtraapi -Wl,-rpath='/opt/htraapi/lib/x86_64"'

htra@ubuntu: S ./bin/SWP_GetSpectrum_Standard

Device is opened successfully

Configuration delievery succeeded.

9.4.2 C++ Project Creation and Compilation

Assuming that the driver files have been correctly configured as per Chapter9.3, if you
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want to create a C++ project for compilation, please refer to the following process:

Write Code: Since the Linux dynamic link library provided with the USB drive is

identical to that in Windows, the code only needs to comply with the APl programming

guidelines.

Compile and Run:

1. Asshown in the figure, first create a new folder to store the entire project (taking
C++_Test as an example), then create a CalFile folder within the folder to store
calibration files, and create an htraapi folder to store header files and dynamic

link libraries.

Desktop  C++_Test

|

CalFile htraapi

2. Create aninc folder under the htraapi folder to store header files, and a lib folder

to store dynamic link libraries.

Desktop |« C++ Test  htraapi

lib

3. Copy the files from the CalFile folder on the provided USB drive to the newly

created C++_Test\CalFile folder.

(J > USBDrive(F) > CalFile Search CalFile
N, Sort ~ = View ~
=
Name Date modified Type Size
023_4248500b000b0036 _ifacal.txt 8/9/2024 10:23 AM Text Document 431 KB
023_4248500b000b0036_rfacal.txt 8/9/2024 10:23 AM Text Document 12,214 KB
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4.

>

Y Home  Desktop

Recent

Home
023

CalFile

023

Desktop 4248500b0  4248500b0

00b0036_  00b0036_

Documents ifacal.bxt rfacal kxt

Downloads

Copy the header files from the Linux\Install_HTRA_SDK\htraapi\inc folder on the

provided USB drive to the newly created C++_Test\htraapi\inc folder.

USB Drive (F) > Linux > Instal HTRA_SDK >  htraapi > inc Search inc
Tl Sort ~ = View ~ “ee
MName Date modified Type Size
[iff htra_api.h 11/25/2024 1:58 PM C/C++ Header 141 KB

top C++ Test htraapi inc

5.

htra_api.h

Refer to the system architecture in Chapter9.1, and then according to the
instructions in Chapter9.2.4, copy the dynamic link libraries corresponding to the
architecture from the Linux\Install_ HTRA_SDK\htraapi\lib folder to the newly
created C++_Test\htraapi\lib folder (taking the x86_64 architecture host
computer as an example).
) > USBDrive(F) » Linux > |Instal HTRASDK > htraapi > lib > x86.64
j:[j] L Sort ~ = View ~ ses
MName - Date modified Type Size
D libgomp.so.1.0.0 11/15/2013 11:24 PM 0 File 59 KB
D libhtraapi.s0.0.55.55 1/6/2025 10:17 AM 55 File 1,087 KB
D libliquid.so 1/12/2024 12:00 AM SO File 1,026 KB
D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 425 KB
D README.txt 1/12/2024 12:00 AM Text Document 1KB
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Desktop C++ Test htraapi lib

libgomp. libhtraapi. libliquid.so  libusb-1.0.

50.1.0.0 50.0.55.55 50.0.2.0

Open the terminal in the lib folder location and enter the following commands to

create soft links for the copied dynamic link libraries (the commands for the

dynamic link libraries of the three architectures are the same):

In -sf libhtraapi.so.0.55.5 libhtraapi.so.0

(Here, the libhtraapi.so library is taken as an example with version 0.55.55; modify the

version number for other versions.)

7.

In -sf libhtraapi.so.0 libhtraapi.so

In -sf libusb-1.0.50.0.2.0 libusb-1.0.50.0
In -sf libusb-1.0.50.0 libusb-1.0.s0

In -sf libgomp.s0.1.0.0 libgomp.so.1

In -sf libgomp.so.1 libgomp.so

Edit
htra@ubuntu:
api.so.0
htra@ubuntu:
htra@ubuntu:
L (5]
htra@ubuntu:
htra@ubuntu:

Home  Desktop C++ Test htraapi lib

libgomp.so libgomp. libgomp. libhtraapi. libhtraapi. libhtraapi. libliquid.so

s0.1 50.1.0.0

libusb-1.0.  libusb-1.0.  libusb-1.0.
50 50.0 50.0.2.0

libhtraapi.so.®.55.55 libhtra

libhtraapi.so.® libhtraapi.se
libusb-1.0.s50.0.2.0 libusb-1.

libusb-1.0.50.8 libusb-1.8.s0
libgomp.so0.1.0.0 libgomp.so.1
libgomp.so.1 libgomp.so

Q =

50 50.0 50.0.55.55

Store the written code files in the outermost folder of C++_Test.

HTRA APl Example Usage Guide 106



Desktop | C++_Test

CalFile htraapi Test.cpp

8. Compile to generate the executable file: First, check the system architecture
according to the process in Chapter 9.1, then open the terminal in the C++_Test
folder (the image below takes the x86_64 system as an example), and input
according to the host system architecture.

1) For x86_64 system input (example test.cpp here):

g++ -0 Test Test.cpp -std=c++11 -l ./htraapi/inc -L ./htraapi/lib -lhtraapi -WI,-

rpath="./htraapi/lib'

2) Input for arrch64 system:

aarch64-linux-gnu-g++-o Test Test.cpp -std=c++11 -I ./htraapi/inc -L ./htraapi/lib -

Ihtraapi -WI,-rpath="./htraapi/lib'

3) For armv7 system, input:

arm-linux-gnueabihf-g++-o0 Test Test.cpp -std=c++11 -I ./htraapi/inc -L ./htraapi/lib -

Ihtraapi -WI,-rpath="./htraapi/lib'

ch Terminal Help
htra@ubuntu: g++ -o Test Test.cpp -std=c++11 -I ./htraapi
/inc -L ./htraapi/lib -lhtraapi -Wl,-rpath="./htraapi/lib’
htra@ubuntu: D
Desktop  C++_Test htraapi lib Q iz
CalFile htraapi Test Test.cpp

9. Run the program: Enter ./Test to start the executable file.

htra@ubuntu: ~/Desktop/C++_Test
File Edit View Search Terminal Help
htra@ubuntu: S g++ -0 Test Test.cpp -std=c++11 -I ./htraapi

/inc -L ./htraapiflib -lhtraapi -Wl,-rpath="./htraapi/lib’
htragubuntu: S ./Test

Device is opened successfully

configuration delievery succeeded
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9.4.

3 C++ Project Cross-Compilation

Under the premise that the host computer has a cross-compilation toolchain, if you

want to cross-compile to use the device, please refer to the following process (taking

the cross-compilation of an aarch64 executable program on an x86_64 host computer

as an example):

1.

1)

2)

o

First, generate the executable file for the target architecture:

Create a project and place the calibration files and header files according to steps
1 to 4 in the compilation and running method in Chapter 9.4.2.

Place the cross-compiled target architecture library files as per step 5. For
example, when cross-compiling an executable for the arrch64 architecture,

please place the library files for the arrch64 architecture.

> USBDrive (F) > Linux >|In5ta||_HTRA_SDK > htraapi > lib > aarch64|

T Sort ~ = View ~

Name Date modified Type Size

[ libgomp.s0.1.0.0 10/9/2013 2:57 AM 0 File 51KB

[ libhtraapiso.0.55.55 1/6/202

D libliquid.so 1/12/2024 12:00 AM SO File 906 KB

D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 490 KB

3)

4)

=l README.txt 1/12/2024 12:00 AM Text Document 1KB

Perform soft linking and program writing storage according to steps 6 to 7.

Compile the executable file using the target architecture compilation command
as described in step 8. The compilation command for the aarch64 architecture is
expected to be used when compiling the executable file for the aarch64 system,

as shown in the figure below.
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Edit
htra@ubuntu:
1 -I ./htraa
htra@ubuntu:~/

es aarch64-1linux-gnu-g++
fhtraapl}llb -lhtraapi -Wl,

-0 Test Test.cpp -std=c++1

-rpath=". fhtraapi/lib’

¥ Home Desktop C#+_Test htraapi lib

Recent
c++

Test.cpp

Home

CalFile htraapi

Desktop

5) After generating the executable file, input 'file Test' to check the architecture of
the executable program, and you will see that the current executable program

architecture is aarché64.

htra@ubuntu: ~/Desktop/C++_Test

File Edit View cearuh Terminal Help
@ 3 $ file Test

Test: object, ARM aarcho64,

inked, interpreter /lib/ld-linux-aarch64.s0.1, for GNU/Linux 3.7.0,

1=664b014870dba5dcb7e25e3eb17432ef378b7b1d, not stripped

htra@ubuntu:

version 1 (SYSV), dynamically 1
BuildID[shal

2. At this point, the executable program has been successfully generated, and you
can now run the program on the aarch64 host machine using the device:

1) Navigate to the project directory (the example project is located on the desktop,
so input 'cd Desktop/'), and compress the entire folder into a zip file, for example,

input 'zip -r C++_Test.zip C++_Test' to create the zip archive.

C++ Test

C++ Tesk.

htra@ubuntu: ~/Desktop
File Edit View
htra@ubuntu:~$ cd Desktop/
htra@ubuntu S zip -r C++_Test.zip C++_Test
adding: C++ _Test/ (stored 0%)
adding: C++_Test/htraapi/ (stored 0%)
adding: C++_Test/htraapi/lib/ (stored
adding: C++_Test/htraapi/lib/libliquid.

Search Terminal Help

(deflated 63%)

zip adding:
adding:
adding:
adding:
adding:
adding:

C++_Test/htraapi/lib/libhtraapi.
C++_Test/htraapi/lib/1libusb-1.8.
C++_Test/htraapi/lib/1libhtraapi.

C++_Test;htraapiflib;libusb-1.0.
C++_Test/htraapi/lib/1libusb-1.8.

C++_Test/htraapi/lib/1libhtraapi

flated 62%)
0. 0 (dcflated 6

0.2.0 (dcflated 65
deflated )
)

adding:
adding:
adding:
adding:
adding:
adding:
adding:

C++_Test/htraapi/inc/ (stored @7
C++_Test/htraapi/inc/htra i.h
C++_Test/Test (deflated 7
C++_Test/CalFile/ (stored 0%)
C++_Test/CalFile/023_4248500b000b00O36_rfacal.txt (deflated
C++_Test/CalFile/023_4248500b000b00O36_ifacal.txt (deflated 6
C++_Test/Test.cpp (deflated 65%)

(deflated 79%)

2) Copy the zip file to the aarch64 host machine.
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File Edit View Sort Go

—

oo #f

# Home Folder

(2 Filesystem Root
-5

& Pictures

Tools

/media/pi/1

Windows

CalFile

nu

X

5

ApplicationGuide

Over

C++_Test.zip

5B Volume

_Z Quick Start GuideV1.1_CN .pdf

w for Documents in Flash Disk_CN.pdf

3) Navigate to the location where the zip file is stored (in this example, the zip file is

on the desktop, so input 'cd Desktop/'), and extract the project (input 'unzip

C++_Test').

C++_Test.zip

C++_Test

pi@raspberrypi:
aspberrypi:
a3 EXE Tae

4) Configure the driver files on the aarch64 host machine as per the steps in

Chapter9.3.

5) After configuring the driver files, input 'cd C++_Test/' to enter the folder, and then

simply input './Test' to run the program.

HTRA APl Example Usage Guide 110



9.5 Using Qt Examples and Project Creation

9.5.1 Using Qt Examples

To use the Qt examples included on the USB drive, provided that the device is properly

connected and the driver files have been configured correctly as per Chapter9.3,

please refer to the following process (the purpose of this Qt example is to obtain

complete spectrum data within a specified frequency band):

1.

Copy the LinuxX\HTRA_Qt_Examples folder from the included USB drive to the
host computer, and then navigate to the HTRA_Qt_Examples\htraapi subfolder

as shown in the figure.

Desktop  HTRA_Qt_Examples  htraapi

Name -~  Size Maodified

htra_api.h

Qt_Make.sh

2. Refer to the system architecture in the process outlined in Chapter 9.1, and then
follow the instructions in Chapter 9.2.4 to copy the dynamic link libraries
corresponding to the system architecture from the
Linux\Install_HTRA_SDK\htraapi\lib folder on the USB drive to the
HTRA_Qt_Examples\htraapi folder (this example uses an x86_64 architecture
host computer).

) > USBDrive(F) > Linux > |Instal HTRASDK > htraapi > lib > x86.64

I T Sort ~ = View ~

Name - Date modified Type Size

D libgomp.so.1.0.0 11/15/2013 11:24 PM 0 File 59 KB
D libhtraapi.s0.0.55.55 1/6/2025 10:17 AM 55 File 1,087 KB
D libliquid.so 1/12/2024 12:00 AM SO File 1,026 KB
D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 425 KB
|j README.txt 1/12/2024 12:00 AM Text Document 1KB
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3.

4.

5.

Desktop HTRA_Qt_Examples htraapi

htra_api.h libgomp.  libhtraapi. libliquid.so libusb-1.0.  Qt_Make.
s0.1.0.0 50.0.55.55 50.0.2.0 sh

Open a terminal in the current folder, enter "sudo sh Qt_Make.sh", and then
follow the prompts to enter the sudo password to grant permission for creating

soft links to the libraries.

htra@ubuntu: ~/Desktop/HTRA_Qt_Examples/htraapi

File Edit View Search Terminal Help
htra@ubuntu: $ sudo sh Qt_Make.sh
[sudo] password for htra:

htra@ubuntu: S I

HTRA_Qt_Examples  htraapi

htra_api.h libgomp.so  libgomp. libgomp.  libhtraapi. libhtraapi. libhtraapi.
50.1 50.1.0.0 50 s0.0 50.0.55.55

libliquid.so libusb-1.0. libusb-1.0. libusb-1.0. Qt_Make.
50 50.0 50.0.2.0 sh

After running the script, use Qt Creator to open the htrademo.pro file in the

htrademo folder.

2 Home Desktop test HTRA Qt Examples htrademo

Recent h

Home

htrademo.
Desktop pro

main.cpp mainwindo mainwindo mainwindo
w.Cpp w.h w.ui

First, select the build environment for the project.
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htrademo - Qt Creator oo

File Edit Build Debug Analyze Tools Window Help

Manage Kits... }9 Build Settings
Edit build configuration: Debug ~ Add -/ Remove | Rename..  Clone..
Active Project General
htrademo =
Import Existing Build... Shadow build: v
Build directory: pp/test/HTRA_Qt_Examples/build-htrademo-Desktop_Qt_5_12_8_GCC_64bit-Debug| | Browse...
Build & Run
Build Steps
[}
= Desktop Qt 5.12.8 GCC 64bit gmake: gmake htrademo.pro -spec linux-g++ CONFIG+=debug CONFIG+=qml|_debug Details ~
B d
» Run Make: make -j4 in /home/| - /Desktop/test/HTRA_Qt_Examples/build-htrade Details ~
© Add Build Step ~
Project Settings Clean Steps
Editor
Code Style Make: make clean -j4 in /fhome/ /Desktop/test/HTRA_Qt_Examples/build-htrader Details ~
Dependencies
herademo -
e clang Code Model Add Clean Step
clang Tools . o
Testing Build Environment
Use System Environment Details ~
1 Issues 2 Search Results 3 Application Output 4 Compile Output 5 QML DebuggerC... 8 TestResults # =

6. Openthe HTRA_Qt_Examples\bin\CalFile folder and ensure that there is a device

calibration file in the folder.

HTRA_Qt Examples bin  CalFile

023 023
4248500b0 4248500b0
00b0036_  00b0036_
ifacal.kxt rfacal.bxt

7. After confirming that there is a calibration file, select any example in main.cpp.

_Enable_GNS5_10MHz.(*
Qs_ExternalTrigger.cop
£ 1QS_GetiQ_EZStandard.cpf
& 1QS_GetiQ_Standard.cpp
& 1Q5_GetiQToTxt.cpp
IQS_GNSS_1PPS.cpp tatiss = Device_Getbe S
QS_LevelTrigger.cpp . evice_Sysp
IQ5_MultiDevsync_fixed.cp
IQS_ScalelQDataToVolts.cp
- 1QS_TimerTrigger.cpp

e mainwindow.cpp
& RTAMode_EZStandard.cpp
£ RTAMode_Standard.cpp
e RTAMode_Standard_perfra
SWP_AutoSetMeasure.cpp
- SWP_CalibrateRefClock.cpf
o SWP_EZGetPartialsweep.ci
& SWP_Fixedtime_GetFrame:
& SWP_Getspectrum_SigAnd
= SWP_GetSpectrum_Standa
& SWP_GetSpectrum_TraceA
& SWP_Getspectrum_Trigger
& SWP_MaxHold_MinHold.cp
& SWP_PickMaxPower.cpp
= SWP_SetfreqCompensatiol
o SWP_TraceAverage.cop

.._Write.cpp
iquid.cpp

arch Results 3 Application Output 4 Compile Output 5 QML Debugger Console 8 Test Results

8. Click Run, and as shown in the figure, the device is functioning normally.
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slv.

1Q5_Enable_GNSS_10MHZ.(*

1Qs_ExternalTrigger.cop
1Q5_GetIQ_EZStandard.cpp
1Q5_GetiQ_Standard.cpp
1Q5_GetiQToTxt.cpp
IQS_GNSS_1PPS.cpp
1Q5_LevelTrigger.cop
1Q5_MultiDevsync_fixed.cp
1Q5_ScalelQDataToVolts.cp
1Q5_TimerTrigger.cpp

mainwindow.
RTAMode_EZStandard.cpp
RTAMode_Standard.cpp
RTAMode_Standard_perfra
SWP_AutoSetMeasure.cpp
SwP_CalibrateRefClock.cpf
SWP_EZGetPartialSweep.cf

SwP_
SWP_GetSpectrum_Sigand
SwP_GetSpectrum_Standa
SWP_GetSpectrum_TraceA
SWP_GetSpectrum_Trigger
SWP_MaxHold_MinHold.cp
SwP_PickMaxPower.cpp
SWP_SetFreqCompensatiol
SWP_TraceAverage.cop

4 Forms

pen Documents
Device_ABOULGNSS.cpp
Device_Ti...tMode.cpp
DSP_AMDemod.cpp
example.h

Write.cop
id.cpp

CRLF)  * Line: 29, Col: 42

winclude “example

statuz

as ended forcefully

02:30:51: Starting /home;
Device s opened successfully
configuration delievery succeeded.

/Desktop/HTRA_Qt_Exasples/bin/htradenc ...

put

5 QML Debuggs
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9.5.2 Qt Project Creation and Compilation

Under the premise that the driver files have been correctly configured according to

Chapter 9.3, if you want to create a Qt project for compilation, please refer to the

following process:

First, when writing code, since the Linux dynamic link libraries provided with the USB

drive are identical to those for Windows, the code only needs to comply with the API

programming guidelines.

Next, the process for creating the project is as follows:

1. Asshown in the figure, first create a new folder to store the entire project (taking
QtTest as an example), then create a bin folder within this folder to store
calibration files and the generated executable files, and create an htraapi folder

to store header files and dynamic link libraries.

Desktop  QtTest

N R

bin htraapi

2. Create a CalFile folder under the bin folder to store the device calibration files.

Desktop  QtTest bin

-

CalFile

3. Copy the files from the CalFile folder on the provided USB drive to the newly

created QtTest\bin\CalFile folder.

J > USBDrive(F) > Calfile Search CalFile
T, Sort ~ = View -
Name Date modified Type Size
023_4248500b000b0036_ifacal.txt 8/9/2024 10:23 AM Text Document 431 KB
023_4248500b000b0036_rfacal.txt 8/9/2024 10:23 AM Text Document 12,214 KB
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Desktop  QtTest

bin CalFile

4.

>

023 023
4248500b0 4248500b0
00b0036_  00b0036_
ifacal.bxk rfacal.kxk

Copy the header files from the Linux\Install_HTRA_SDK\htraapi\inc folder on the

provided USB drive to the newly created QtTest\htraapi folder.

USB Drive () >

Name

[k htra_api.h

Desktop = QtTest

Linux > Install HTRA SDK > htraapi >

T Sort ~

htraapi

inc Search inc
View - see
Date modified Type Size
11/25/2024 1:58 PM C/C++ Header 141 KB

htra_api.h

5. Refer to the system architecture in Chapter 9.1, and then according to Chapter
9.2.4, copy the dynamic link libraries corresponding to the system architecture
from the Linux\Install_HTRA_SDK\htraapi\lib folder on the provided USB drive to
the newly created QtTest\htraapi folder (taking the x86_64 architecture for the
host computer as an example).

J > USBDrive(F) > Linux > |Install HTRASDK > htraapi > lib > x8664

0 T sort ~ = View ~ wee

Name - Date modified Type Size

D libgomp.so.1.0.0 11/15/2013 11:24 PM 0 File 59 KB
D libhtraapi.so.0.55.55 1/6/2025 10:17 AM 55 Fi 1,087 KB
D libliquid.so 1/12/2024 12:00 AM SO Fi 1,026 KB
D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 425 KB
D README. tut 1/12/2024 12:00 AM Text Document 1KB
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Desktop  QtTest  htraapi

htra_api.h libgomp. libhtraapi. libliquid.so libusb-1.0.
50.1.0.0 50.0.55.55 50.0.2.0

6. Open a terminal at the location of the htraapi folder and enter the following
command to create a soft link for the copied dynamic link libraries (the soft link
command for different architectures is the same):

® [n -sf libhtraapi.so.0.55.5 libhtraapi.so.0
(Here, the libhtraapi.so library is taken as an example with version 0.55.55;
modify the version number for other versions.)

® |n -sf libhtraapi.so.0 libhtraapi.so

® |n-sflibusb-1.0.50.0.2.0 libusb-1.0.50.0

® |n-sflibusb-1.0.50.0 libusb-1.0.s0

® |n-sflibgomp.so0.1.0.0 libgomp.so.1

® |n-sflibgomp.so.1 libgomp.so

Edit Viev
htra@ubuntu: 5 - 1ibhtraapi.so.8.55.55 libhtraapi.so
.0
htra@ubuntu: - 1ibhtraapi.so.® libhtraapi.so

htra@ubuntu: - libusb-1.0 .0.2.0 libusb-1.0.50.0
htra@ubuntu: - libusb-1.06 .0 libusb-1.08.s50
- libgomp.so.1.0.0 libgomp.so.1
libgomp.so.1 libgomp.so

Home  Desktop QtTest  htraapi Q H= =

htra_api.h libgomp.so  libgomp. libgomp. libhtraapi. libhtraapi. libhtraapi.
50.1 50.1.0.0 o] s0.0 50.0.55.55

libliquid.so  libusb-1.0.  libusb-1.0.  libusb-1.0.
50 50.0 50.0.2.0

7. Open Qt Creator, click on File, and select New File or Project.
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Edit Euild Debug Analyze Tools Window Help

& New File or Project... cerl+N
[ Open File or Project... Ctrl+0
Open File With... |
Recent Files » a
Recent Projects 4
Sessions » | Tutorial Tutorial Tutorial Tutorial
] U | N
- ing and Runn... Help: Creating a Mobile . Help: Creating a Qt Qui... Help: Creating a Qt Wid...
SaVEA“ Ctrl+Shift+S Tags: qf gt quick desig Qm Tags: qt gt de n Tags: qf
Tutorial Tutorial
| 1
-
Exit ctrl+Q . ) oaoe 128
e aeang Started Pr... Help: Getting Started Pr... Online: Digital Instrume... Online: Getting Started ...
L Ot Account - B ~ N
ags: qtquick controls tumbler help ags: qt qtereator qtdesigner widget 205 qto ags: o
B Online Community
S\ Blogs
@ UserGuide

4 compile Output 5 QML DebuggerC... 8 TestResults +

8. Select Create Qt Widgets Application.

File Edit EBuild Debug
New File or Project — Qt Creator

Choose a template:

All Templates -
Projects
PcheLs > Qt Widgets Applicati Creates a Qt application for the -
Examplet desktop. Includes a Qt Designer-

Library based main window. Tutorial

Qt Console Application
Preselects a desktop Qt for building
the application if available. Sz

Qt for Python - Empty
Supported Platforms: Desktop 1

other Project
Non-Qt Praject
Import Project

Files and Classes

t For Python - Window
Newto Q | c++ E @ Y reating a Qt Wid...

Leamhowto, | Modeling
own applicatit t Quick Application - Empt
explare g | Qe PP Py
GLSL
Get start | General Qt Quick Application - Scroll
Java
Python @ Qt Quick Application - Stack
m Qt Quick Application - Swipe
13:28
| Getting Started ...
A Oticcoun
M Online Cor

S\ Blogs

@ usercuide

1 Issues 2 Search Results

e to locate (Ctrl... 3 Application Output 4 Compile Output 5 QML Debugger C 8 Test Results & =

9. After filling in the project name, click Browse to change the project path.
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Qt Widgets Application — Qt Creator 3

) Project Location
2 Location

This wizard generates a Qt Widgets Application project. The application derives by
default from QApplication and includes an empty widget.

Name: [Test|

Create in: |/home/: = Browse...

Use as default project location

Cancel

10. Select the directory as the QtTest address created in the first step and click Open.

Choose Directory

Recent 4 IEDesktop QtTest ’I

Home Name v Size Modified

Desktop @ htraapi 03:49
& bin 03:42

Documents

11. After selecting the path, click Next.

Qt Widgeks Application — Qt Creator >

] Project Location
2 Location

This wizard generates a Qt Widgets Application project. The application derives by
default from QApplication and includes an empty widget.

Name: Test

I:reate in: |/home/. - »/Desktop/QtTest I

Use as default project location
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12. Click Next to continue.

Qt Widgets Application — Qt Creator .

Define Build System

Location
2 Build System Build system: | gmake

< Back Cancel

13. Click Next to continue.

Qt Widgets Application — Qt Creator X

Class Information

Location
Build System Specify basic information about the classes For which you want to generate
9 Details skeleton source code files.

Class name: [Mainwindow|

Base class: | QMainwindow

Header file: |mainwindow.h
Source file: \mainwindow.cpp
v| Generate form

Form file:  |mainwindow.ui

< Back Cancel

14. Click Next to continue.

HTRA API Example Usage Guide 120



Qt Widgets Application — Qt Creator .

Translation File

Location
Build System IF you plan to provide translations For your project’s user interface via the Qt Linguist
Details tool, please select a language here. A corresponding translation (.ts) file will be

generated for you.
2 Translation
Language: <none> v

Translation Ffile: |<none=

< Back Cancel

15. Select the x86_64 build environment for the project and then continue by clicking

next.

Qt Widgeks Application — Qt Creator .

) Kit Selection
Locakion

Build System The following kits can be used for project Test:

Details Type to Ffilter kits by name...

Translation
» Kits

I select all kits

v| B Desktop Qt 5.12.8 GCC 64bit Details ~

I arrch64 Details =

< Back Cancel |

16. Click Finish to create the project.
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Qt Widgets Application — Qt Creator <

Project Management

Location

Build System

Details
Translation
Kits

2 summary

m Test.pro
» [l Headers
~ lie Sources
le+| main.c|
lcx mainwi
v |4 Forms

Add as a subproject to project:

Add to version control:

Files to be added in

<None> * | | Configure...

/home/zhangguorong/Desktop/QtTest/Test:

Test.pro
main.cpp

mainwindow.cpp

mainwindow.h
mainwindow.ui

<Select symbol> % Unix (LF) % Line: 1, Col: 1

-hm

Build
Run qmake

Run

Rebuild

Clean

Add New...

Add Existing Files...

Add Existing Directory...

ion>

char *argv[])

arge, argv);

Add Library...

Open Documents

Find in This Directory...

Close AllFiles in Project "Test"
Close Project "Test"

Collapse All
Expand All

]

L. Type to locate (Ctrl...

1 Issues

2 Search Results 3 Application Output 4 Compile Output 5 QML Debugger C...

8 Test Results & = O

18. Select External Library and click Next.
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Add Library — Qt Creator

Library Type
Choose the type of the library to link to

¥ Type ) Internal library

Yetails Links to a library that is located in your build tree.
Adds the library and include paths to the .pro file.

‘e External library

Links to a library that is not located in your build
re

e
Adds the library and include paths to the .pro file.
_ System library

Links to a system library.
Neither the path to the library nor the path to its
includes is added to the .pro file.

() system package
Links to a system library using pkg-config.

=] el

19. Click Browse Library File.

Add Library — Qt Creator

External Library
Specify the library to link to and the includes path

Type Library type: \Linux (lib*.s0 lib*.a)
» Details Library file: |

Include path: ‘

Platform Linkage:
Linux
Mac
windows.

Mac: Library
(@) Library
Windows:

Library inside "debug" or "release" subfolder
|| Add "d" suffix for debug version

| <Back | next> || cancel |

20. Select Q Test\htraapi, the library previously copied and soft-linked, and click Open.

Choose File

[ Desktop I QtTest = htraapi | >|

Name ¥ Size Modified
[ libusb-1.0.50 434.8kB 29 Apr 2024
[ libliquid.so 1.1MB 29 Apr2024

i libhtraapi.so 927.6kB 24 Nov 2024

21. Select the Linux platform and click Next.
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External Library

Add Library — Qt Creator

Specify the library to link to and the includes path

Type
> Details
Summary

Library type: ‘Linux (lib*.so lib*.a) - ‘

Library file: ’ong/Desktup/‘QtTest,‘htraapi/lihhtraapi.sa‘ | Browse... ‘

Include path: ﬁe/zhanggunrcmg/Desktup/QtTest,’htraapi‘| Browse... ‘

PlatForm Linkage: Dynamic
| Mac
| windows

side "debug” or "relea:

uffix for debug version

| <Back || Next> | cancel |

22. Click Finish to add the external library.

Type
Details
2 Summary

Add Library — Qt Creator

Summary

The following snippet will be added to the
Test.pro file:

unix:!'macx: LIBS += -L$$PWD/../htraapi/ -lhtraapi

INCLUDEPATH += $$PWD/. . /htraapi
DEPENDPATH += $SPWD/ . ./htraapi

< Back ” Finish ” Cancel

23. Asshown below, add DESTDIR = $Sclean_path(SSPWDY/...) after CONFIG += c++11.

/bin) (this step specifies where the executable is generated)
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Projects 3T e B Testpro*

B Test.pro
» [ Headers greaterThan(QT_MAJOR_VERSION, 4): QT += widgets

~ lcd Sources

Unix (LF)

QT += core gui

CONFIG += c++11
|

les] main.cpp
- mainwindow.cpp 7| oesTorr = $5 ath($$PWD/. . /bin)| |
* i Forms
# The following define makes your compiler emit warnings if you use
any Qt feature that has been marked deprecated (the exact warnings
W depend on your compiler). Please consult the documentation of the
# deprecated API in order to know how to port your code away from it.
Debug DEFINES += QT_DEPRECATED_WARNINGS
Ve You can also make your code fail to compile if it uses deprecated APIs.
Projects In order to do so, uncomment the following line.
# You can also select to disable deprecated APIs only up to a certain version of Qt.
(2] #DEFINES += QT_DISABLE_DEPRECATED_BEFORE=0x060000  # disables all the APIs deprecated before Qt 6.0.0

SOURCES += \
main.cpp \
mainwindow. cpp

HEADERS += \
mainwindow.h

FORMS += \
mainwindow.ui

ault rules for deployment.
target.path = /tmp/$${TARGET}/bin

: unix:landroid: target.path = /opt/$${TARGET}/bin
y(target.path): INSTALLS += target

unix:!imacx: LIBS += -L$$PWD/../htraapi/ -lhtraapi

INCLUDEPATH += $$PWD/../htraapi
DEPENDPATH += $$PWD/../htraapi

1 Issues 2 Search Results 3 Application Output 4 Compile Output 5 QML DebuggerC... 8 TestResults ¢ = 0

24. Asshown in the figure below, after the library file, add

-WI,-rpath,SSPWD/... /htraapi

(this step specifies the library path for the executable).

Test.pro @ Test - Qt Creator

Eile Edit Build Debug Analyze Tools window Help
< B Test.pro*
qr

Projects
E Test.pro

» |5 Headers
~ li& Sources
le«] main.cpp

Unix (LF) 2 Line: 35, Col: 70

core gui
greaterThan(QT_MAJOR_VERSION, 4): QT += widgets

CONFIG += c++11

e-) mainwindow.cpp DESTDIR = $$clean_path($$PWD/. . /bin)
¢ |id Forms
# The following define makes your compiler emit warnings if you use
# any Qt feature that has been marked deprecated (the exact warnings
# depend on your compiler). Please consult the documentation of the
# deprecated API in order to know how to port your code away from it.

DEFINES += QT_DEPRECATED_WARNINGS

# You can also make your code fail to compile if it uses deprecated APIs.

# In order to do so, uncomment the following line

# You can also select to disable deprecated APIs only up to a certain version of Qt.

EDEFINES += QT_DISABLE_DEPRECATED_BEFORE-Dx050060 ¥ disables all the APIs deprecated before Qt 6.0.8

SOURCES
main.cpp \
mainwindow. cpp

HEADERS += |
mainwindow. h

Open Documents FORMS

mainwindow. ui

% Default rules for deployment.

gnx: target.path = /tmp/$${TARGET}/bin

else: umix:landroid: target.path = /opt/$${TARGET}/bin
tisEmpty(target.path): INSTALLS += target

uni

macx: LIBS += -L§$PWD/../htraapi/ -lhtraapi -1ligquid -lusb-1.9

INCLUDEPATH += $$PWD/../htraapi
DEPENDPATH += $$PWD/../htraapi

LBl . Type to locate (Ctr 1 Issues 2 Search Results

3 Application Output 4 Compile Output 5 QML Debugger C... 8 Test Results =+

25. Save the Test.pro file and write the code in mainwindow.cpp afterwards.
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mainwindow.cpp @ Test - Qt Creator

File Edit Build Debug Analyze Tools Window Help
mainwindow.cpp

- lici Test
|.@ Test.pro
» |&i Headers
~ lied Sources

"mainwindow.h"
"ui_mainwindow.h"
<QDebug>

#include
#include
#include

#include <htra_api.h>

le-| main.cpp #include <stdio.h>
® mainwindow.cpp #include <string.h>
* la Forms #include <vector>

using namespace std;

Mainkindow: :MainWindow(QWidget *parent)
: QMainWindow(parent)
- , ui(new Ui::Mainkindow)

DeviceInfo_TypeDef DeviceInfoj
Status = Device_QueryDeviceInfo(&Device, &DeviceInfo);

|8l £ Type to locate (Ctrl 1 Issues 2 Search Results 3 Application Output 4 Compile Output 5

Mainwindow:MainWindow(QWi... %

{
ui-»setupli(this);
int Status = 8;
void* Device ULL;
int DevNum = 8;
BootProfile_TypeDef BootProfile;
BootInfo_TypeDef BootInfo;
BootProfile.DevicePowersupply = USBPortAndPowerPort;
Open Documents BootProfile.Physicalinterface = USB;
~| 28 Status = Device_Open(&Device, DewNum, &BootProfile, &BootInfo);
- if (Status == APIRETVAL_MoError) {
qDebug () TON__ << __LINE__ << "Device opened successfull";
- 1 else
abebug () _LINE__ << "Device failed to open!";
abebug () __LINE__ << "Status = " << Status;
1

QML Debugger C...

Unix (LF) 2 Line: 28, Col: 68

8 Test Results

26. After writing the code correctly, click run. As shown in the figure, you can see that

the program is running normally in the application output.

mainwindow.cpp @ Test - Qt Creator

File Edit Build Debug Analyze Tools Window Help
Projects > < mainwindow.cpp B Mainwindo:
~ li Test #include

"mainwindow.h"

= Test.pro #include "ui_mainwindow.h"
+ i Headers #include <QDebug>
7l sources #include chtra_api.h>
(| main.cop #include <stdio.h>
mainwindow.cpp #include <string.h>
+ lid Forms #include <vector>

using namespace std;

MainWindow: :MainWindow(QWidget +parent)
: QMainWindow(parent)
- , Ui (new Uiz :MainWindow)

ui->setupUi(this);
int Status = 03

NULL;
int DevNum = 0;

void+ Device

BootProfile_TypeDef BootProfile;
BootInfo_TypeDef BootInfo;

Open Documents s g Application Output ey~ rilter

main.cpp Test ¥

mainwindow.c| .

Test.pro Maindindow 38 Device opened successfull
Maindindew 51 Configuration successfull
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -83.1369
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -79.4426
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -B7.5744
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[G] = -88.3917
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -B9.2067
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -92.8413
Maindindow 80 Frequency[0] = -6.62109e+06 ; PowerSpec_dBm[@] = -77.6308

+|MainWindow 80 Frequency[8] = -6.62109¢+06 ; PowerSpec_dBm[@] = -85.4191

[ 8] Type to locate (Ctrl.

1 Issues 2 Search Results 3 Application Output

ainwindow(QWi... +

4 Compile Output 5 QML Debugger C...

Unix (LF) + | Line: 28,Col:68 B+

8 Test Results =

27. Close Qt Creator, enter the QtTest\bin folder, open the terminal, and type ./Test

to run the executable program.
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i _|@ubuntu: ~/Desktop/QtTesk/bin

File Edit View Search Terminal Help

(base) ~n J@ubuntu:~/Desktop/QtTest/bins ./Test
MainWindow 44 Device opened successful!
MainWindow 65 Configuration successful!
MainWindow 94 Frequency[@] -6 109e+06 ; PowerSpec_dBm[8] -86.0967
MainWindow 94 Frequency[@] 6 109e+06 ; Power c_dBm[8] -87.1682
MainWindow 94 Frequency[@] -6.6210%9e+06 ; PowerSpec_dBm[®] = -89.3518

9.5.3 Cross-compiling Qt projects

Under the premise that the host computer has a cross-compilation toolchain, if you
want to cross-compile to use the device, please refer to the following process (taking
the cross-compilation of an aarch64 executable program on an x86_64 host computer
as an example):

1. First, generate the executable file for the target architecture:

1) Create the project and place the calibration files and header files according to

steps 1 to 4 of the QtProject Creation and Compilation.

2) Place the cross-compilation target architecture library files according to step 5 of
the form program creation process. For example, if you expect to cross-compile
an executable for the arrch64 architecture, please place the library files for the

arrch64 architecture.

[J > USBDrive(F) » Linux >|Insta||_HTRA_SDK > htraapi > lib > aarch64|

T Sort ~ = View ~ e
~
Name Date modified Type Size
D libgomp.s0.1.0.0 10/9/2013 2:57 AM 0 File 51KB
D libhtraapiso.0.55.55 1/6/2025 10:17 AM 55 File 1,087 KB
D libliquid.so 1/12/2024 12:00 AM SO File 906 KB
D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 490 KB
=l README.txt 1/12/2024 12:00 AM Text Document 1KB

3) Create a soft link for the dynamic link library according to step 6 of the form

program creation process.
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4) Create the program according to steps 7-13 of the form program creation
process, and in step 14, select the build kit for the cross-compilation target
architecture (for example, in this example, select the build kit for the arrch64

architecture).

Qt Widgets Application — Qt Creator %

) Kit Selection
Locakion

Build System The following kits can be used for project untitled:

Details Type to Ffilter kits by name...

Translation
¥ Kits

I select all kits

& Desktop Qt 5.12.8 GCC 64bit Details ~

v| B arrch64 Details -

< Back Cancel

5) Follow steps 16-26 of the form program creation process to create the project,
reference the libraries, modify the location for generating the executable
program, and write the project.

6) Click the build button in the lower left corner to build the executable program.
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mainwindow.cpp @ Test - Qt Creator (]

Eile Edit Build Debug Analyze TIools Window Help
[ =T & E = mainwindow.c + X | <Select Symbol> % Unix (LF) + Line: 1, Col: 1 B
- lidl Test 1 sinclude © =
D L= Test.pro #include "
Welcome + i Headers #include <QDebu;
=] ~ li! sources
; sinclude <
o = main.cpp #includ
mainwindow.cpp sinclude ¢
v [ Forms #include <v
using namespace std;
MainWindow: :MainWindow(QWidget *parent)
: QMainWindow(parent)
< , wi(new Uis:MainWindow)
{
ui->setupli(this);
int Status = @;
oids Device = NULL;
int Devium = @;
BootProfile TypeDef BootProfile;
BootInfo_TypeDef BootInfo;
‘ [
L
Open Documents + B+ @ Issues &3 YR ~. Filte =]
mainwindow.cpp 4
s [ B |

1 Issues 2 Search Results 3 Application... 4 Compile Out... 5 QMLDebugg... 8 TestResults #

¢ PR

7) After building the executable program, open the terminal in the QtTest\bin
folder and type file Test to check the architecture of the executable program (the
name of the executable program here is Test, so type file Test).

htra@ubuntu: ~/Desktop/QtTest/bin

File Edit View Search Terminal Help
S file Test

ELF 64-bit LSB shared object, ARM aarch64, version 1 (5YSV), dynamically 1
, interpreter /lib/ld-linux-aarch64.s0.1, for GNU/Linux 3.7.0, BuildID[shal
bo14870dbasdcb7e25e3eb17432ef378b7b1d, not stripped

htra@ubuntu: S

2. At this point, the executable program has been successfully generated, and you
can now run the program on the aarch64 host machine using the device:

1) Navigate to the project location (in this example, the project is located on the
desktop, so type cd Desktop/), and compress the entire folder into a zip file, for

example, type zip -r Qt Test.zip Qt Test to create a zip archive.
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2)

3)

4)

5)

File Edit V
htra@ubunt
htra@ubunt
updating:
updating:
updating:
updating:
updating:
updating:
updating:
updating:
updating:
updating:
updating:

htra@ubuntu: ~/Desktop

iew Search Terminal Help

u:~S$ cd Desktop/

uz~f top$ zip -r QtTest.zip QtTest

QtTest/ (stored 8%)

QtTest/htraapi/ (stored 8%)
QtTest/htraapi/libliquid.so (deflated 60%)
QtTest/htraapi/libhtraapi.so.0.55.53 (deflated 64%)
QtTest/htraapi/libusb-1.8.50.0 (deflated 62%)
QtTest/htraapi/libhtraapi.so.® (deflated 64%)
QtTest/htraapi/libusb-1.0.50.0.2.0 (deflated 62%)
QtTest/htraapi/libusb-1.0.s50 (deflated 62%)
QtTest/htraapi/libhtraapi.so (deflated 64%)
QtTest/htraapi/htra_api.h (deflated 79%)
QtTest/Test/ (stored 0%)

Copy the zip file to the aarch64 host machine.
s O v O 7 |/media/rpdzkij/1E2A-96E8/te!
Places v —
_L. U - JUIUC [ )
O[S ev4[oll ] Desktop QtTest.zip

1 | Trash Can

—

Navigate to the location of the compressed package (in this example, the

compressed package is located on the desktop, so input cd Desktop/), and unzip

the project (input unzip QtTest here).

- »

File Edit
rpdzkj@loc
rpdzkj@loc

rpdzkj@localhost: ~/Desktop

Tabs Help

alhost:
alhost:

0t

Configure the driver files on the aarch64 host machine as per the steps in

Chapter9.3.

After configuring the driver files, input cd QtTest/ to enter the folder, then input

chmod

777 Test to provide execution permissions for the program, and finally

input ./Test to run the program.
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-

File Edit Tabs Help
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9.6 Usage of Python examples and project creation

9.6.1 Usage of Python examples

Assuming the device is properly connected and the driver files have been configured

correctly as per Chapter 9.3, if you want to use the Python examples included on the

USB drive, you can refer to the following process (the specific functions of the Python

examples can be directly viewed in Chapter 4.2):

1.

2.

Copy the Linux\ HTRA_ Python_ Examples folder from the included USB drive to
the host computer, then open a terminal in the HTRA_ Python_ Examples folder
and input which python3 to check the location of the Python interpreter (for

example, it may be located at /usr/bin).

htra@ubuntu: ~/Desktop/HTRA_Python_Examples

File Edit View Terminal Help

htra@ubuntu:~ »/HTRA_Python_ExamplesS which python3
fusr/bin/python3

htra@ubuntu:~, ktop/HTRA_Python_Examples$

Based on the interpreter address obtained earlier, input sudo cp -r CalFile /usr/bin
to copy the device calibration file to the same directory as the interpreter
(Python3) (for example, in this case, the same directory is /usr/bin; if the actual
interpreter location is different, modify the address accordingly).

htra@ubuntu: ~/Desktop/HTRA_Python_Examples

File Edit View
htra@ubuntu:~ »/HTRA_Python_Examples$ which python3

fusr/bin/pyt

htra@ubuntu ) /HTRA_Python_Examples$ sudo cp -r CalFile fusr/bin
[sudo] password for htra:

htra@ubuntu:~ op/HTRA_Python_Examples$ I

First, refer to the system architecture in Chapter9.1, then according to
Chapter9.2.4, copy the dynamic link libraries from the corresponding system
architecture folder under the included usB drive
Linux\Install_ HTRA SDK\htraapi\lib to the HTRA_Python_ Examples\htraapi

folder (this example uses the x86_64 architecture host computer).
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CJ > USBDrive(F) > Linux > |InstalHTRASDK > htraapi > lib > x86.64

Ia) T Sort ~ = View - “ee
)
Name Date modified Type Size
D libgomp.so.1.0.0 11/15/2013 11:24 PM 0 File 59 KB
D libhtraapi.so.0.55.55 1/6/2025 10:17 AM 55 File 1,087 KB
D libliquid.so 1/12/2024 12:00 AM SO File 1,026 KB
D libusb-1.0.50.0.2.0 1/12/2024 12:00 AM 0 File 425 KB
E README.xt 1/12/2024 12:00 AM Text Document 1KB

Desktop  HTRA_Python_Examples  htraapi

libgomp. libhtraapi. libliquid.so libusb-1.0. Py _Make.sh
50.1.0.0 50.0.55.55 50.0.2.0

Open a terminal in the current folder and input "sudo sh Py_Make.sh", then
follow the prompts to enter the sudo password to provide permissions for

creating soft links to the libraries.

htra@ubuntu: s

[sudo] password for htra:
htra@ubuntu: S |:|

Home  Desktop  HTRA_Python Examples  htraapi

libgomp.so  libgomp. libgomp.  libhtraapi. libhtraapi. libhtraapi. libliquid.so
50.1 50.1.0.0 50 50.0 50.0.55.55

libusb-1.0.  libusb-1.0.  libusb-1.0. Py Make.sh
50 50.0 50.0.2.0

In the HTRA_ Python_ Examples location, open a terminal and input python3
SWPMode_Standard.py to run the example. (This example uses
SWPMode_Standard.py as an example)

htra@ubuntu: ~/Desktop/HTRA_Python_Examples

File Edit View Search Terminal Help
htra@ubuntu: S python3 SWPMode Standard.py

Device is opened successfully
configuration delievery succeeded
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9.6.2 Python Project Creation

Under the premise that the driver files have been correctly configured according to
Chapter9.3, if you want to create and write a Python project, please refer to the
following process:

First, when writing code, since the Linux dynamic link library provided with the USB
drive is identical to that in Windows, the code only needs to comply with the API
programming guidelines.

Secondly, when running the program, simply place the program in the example folder

and follow the process outlined in Python Example Usage.
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9.7 GNU Radio Module Construction and Use

After the device is properly connected and the driver files are configured as described
in Section 9.3, you can use the device with GNU Radio in either of the following two

ways.
9.7.1 Architecture and Operating System Requirements

B Architecture: x86_64

B Operating System: Ubuntu22.04 or later

B GNU Radio Version: 3.9 or later

Enter uname -a in the terminal to check whether your operating system and
architecture meet the requirements for running the HAROGIC spectrum analyzer in

GNU Radio. If they do not, please update to the required versions.

[+ htra@htra: ~/Desktop

S uname -a

Linux htra 6.8.0-40-generic #40--22.04.3-Ubuntu SMP PREEMPT_DYNAMIC Tue Jul 38

17:30:19 UTC 2 x86 64Ix86_64 Xx86_64 GNU/Linux
- $

9.7.2 Installing and Configuration GNU Radio

1. Intheterminal, enter sudo apt update && sudo apt-get install gnuradio and wait
for the installation to complete;
2. In the terminal, enter gnuradio-config-info --version to check the installed

version and ensure that GNU Radio was installed successfully;
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[+1

htra@htra: ~/Desktop

et:1 http //security.ubuntu.com/ubuntu jammy-security InRelease [129 kB]
it:2 http://mirrors.tuna.tsinghua.edu.cn/ubuntu jammy InRelease
et:4 http://security.ubuntu.com/ubuntu jammy-security/main amd64 DEP-11 Metadat

9.7.3 Building the HRTA OOT Module

S sudo apt update && sudo apt-get install gnuradio I

://mirrors.tuna.tsinghua.edu.cn/ubuntu jammy-updates InRelease

triggers
triggers
triggers
triggers
triggers
triggers
triggers

triggers

for desktop-file-utils (0.26-1ubuntu3) ...

for hicolor-icon-theme (0.17-2) ...
for gnome-menus (3.36.0-1ubuntu3) ...
for libc-bin (2.35-0ubuntu3.8) ...

for man-db (2.10.2-1) ...

for shared-mime-info (2.1-2) ...

for mailcap (3.70+nmulubuntul) ...

for fontconfig (2.13.1-4.2ubuntu5) ...
$ .gnuradio-config-info -

N |

-version

1. Open the terminal and enter: sudo apt update && sudo apt install -y git cmake

g++ libpython3-dev python3-numpy python3-pip python3-setuptools pybind11-

dev, this will install all the toolchains and dependencies required to build GNU

Radio and third-party modules in one step.

htra@htra: ~/Desktop

$ sudo apt update && sudo apt install -y git cmake g++
11bpythcn3 dev python3-numpy python3-pip python3-setuptools pybindii-dev

[Sudo| password Tor htra:

Hit:1 http://mirrors. tuna.tsinghua.edu.cn/ubuntu jammy InRelease
Get:2 http://mirrors.tuna.tsinghua.edu.cnfubuntu jammy-updates InRelease [

128 kB]

Get:3 http://mirrors.tuna.tsinghua.edu.cnfubuntu jammy-backports InRelease

[127 kB]

Setting
Setting
Setting
Setting
Setting
Setting
setting
Setting

up
up
up
up
up
up
up
up

Processing
Processing

git-man (1:2.34.1-1ubuntul.15) ...

cmake-data (3.22.1-1ubuntul.22.04.2) ...
Libalgorithm-diff-xs-perl (0.04-6build3) ...

libalgorithm-merge-perl (8.08-3) ...

dpkg-dev (1.21.1ubuntu2.6) ...

git (1:2.34.1-1ubuntu1.15) ...

cmake (3.22.1-1ubuntul.22.84.2) ...
build-essential (12.9%ubuntu3) ...
triggers for man-db (2.10.2-1) ...

triggers for libc-bin (2.35-8ubuntu3.11) ...

S

= jm|

2. Inthe terminal, enter: git clone https://qithub.com/HAROGIC-Technologies/qr-

htra.git to download the HTRA OOT module(Alternatively, the gr-htra folder may

be obtained directly from the Linux\HTRA_Gnuradio_Examples folder within the

accompanying documentation.);
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https://github.com/HAROGIC-Technologies/gr-htra.git
https://github.com/HAROGIC-Technologies/gr-htra.git

htra@htra: ~/Desktop

] $ git clone https://github.com/HAROGIC-Technologies/gr-htra.git
into 'gr-htra“ s

e: Enumerating objects: 248, done.

: Counting objects: 100% (5/5), done.

: Compressing objects: 100% (5/5), done.

e: Total 248 (delta 1), reused © (delta @), pack-reused 243 (from 1)

Receiving objects: 100% (248/248), 4.27 MiB | 118.00 KiB/s, done.

(114/114), done.

Resolving deltas: 1@

- |

In the terminal, enter cd gr-htra to navigate to the root directory of the HTRA

OOT module;

Enter mkdir build && cd build to create a build directory under the project root

and switch to it;

Enter sudo cmake .. && sudo make install to configure the project, compile the

source code, and install the module to the system directory.

htra@htra: ~/Desktop/gr-htra/build

$ cd gr-htra/
S mkdir build && cd build

[sudo] password for itra:

$ sudo cmake .. && sudo make install

-- The CXX compiler identification is GNU 11.4.0
-- The C compiler identification is GNU 11.4.0
- Detecting CXX compiler ABI info

[ 66%]

[ 66%] Built target gnuradio-htra_device

[ 83%]
[100%]

Lto-wrapper: warning: using serial compilation of 6 LTRANS jobs
[100%] Built target htra_source

Install configuration:
Installing: /usr/local/include/htra_device/htra_source.h
Installing: /Jusr/local/lib/libgnuradio-htra_device.a
-- Installing: /usr/local/share/gnuradio/grc/blocks/htra_device_htra_source.block.yml
- Installing: /usr/local/lib/python3.10/dist-packages/htra_source.cpython-310-x86_64-1linu

X-gnu.so

"Release

A |

Copy the instrument's calibration files into the gr-htra/CalFile folder, then run cd..

&& sudo sh CopyCalFile.sh to install the device calibration files.

r

1

udo] password for htra

A
CalFile H Q E |~ = u] x

Recent

Starred 023
333251100

Home 03e0029_... 03e0029_...

Desktop

htra@htra: ~/Desktop/gr-htra

. &%& sudo sh CopyCalFile.sh
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9.7.4 Uninstalling the HTRA OOT Module

To uninstall the HTRA OOT module along with its related configuration files, run the

following command in the gr-htra folder: sudo sh uninstall.sh.

9.7.5 Running the HTRA OOT Module

The following section demonstrates the operation of the HTRA OOT module using a

USB device as an example.

1. Connect the device to the host computer, then enter Isusb in the terminal. If the
output shows IDs 6430, 3675, 04b5, or 3671, it indicates that the instrument is
correctly connected to the host.

(If the host is a virtual machine, after a successful connection, you can check the

hardware device icon at the bottom-right corner of the VM interface. Hovering the

mouse over the icon should display the HTRA logo, confirming that the device is

connected to the VM. Also, ensure that the USB compatibility setting is set to USB 3.1

to guarantee proper device operation.)

htra@htra: ~/Desktop

Device B HTRA HTRA
Device B Linux Foundation 3.0 root hub
Device B VMware, Inc. Virtual USB Hub
Device B VMware, Inc. Virtual USB Hub
Device H VMware, Inc. Virtual Mouse
Device H Linux Foundation 2.8 root hub
1 Device H Linux Foundation 2.8 root hub
Device B VMware, Inc. Virtual USB Hub
Device B VMware, Inc. Virtual Bluetooth Adapter
Device H Linux Foundation 1.1 root hub

2. Inthe terminal, navigate to the built gr-htra folder and enter gnuradio-

companion to launch the graphical interface;
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htra@htra: ~/Desktop

B S gnuradio-companion
=> Warning: vocoder_codec/_decode_ps - option_attributes are for enums only, ignorin

: vocoder_codec2_encode_sp - option_attributes are for enums only, ignorin
c<< Welcome to CGNU Radio Companion 3.10.1.1 >>>
Block paths:

Jusr/share/gnuradio/grc/blocks
Jusr/local/share/gnuradio/grc/blocks

untitled - GNU Radio Companion S O €
File Edit View Run Tools Help
o 7 ﬁ > 9 [ &= ? > ¥
Options Variable v Core

Title: Not titled yet ID: samp rate > Audio

Qutput Language: Python Value: 32k 5 Boolean O

Generate Options: QT GUI ]
> Byte Oper
» Channelize
» Channel M
> Coding
» Control Po
% Puakaia Tasl

In the GNU Radio Companion graphical interface, press Ctrl+F to open the

search box. Enter HTRA in the top-right corner and press Enter to load HTRA: IQ

Source into the flowgraph;

*untitled - GNU Radio Companion - o X
File Edit View Run Tools Help
s P~ 010 s A e v
@ htra [x]
HTRA
Options Variable HTRA: 1Q Source

Title: Not titled yet
Output Language: Python
Generate Options: 0T GUI

1D: samp_rate
Value: 32k

HTRA: 1Q Source
Physical Interface: USE
Device Number: 0
‘Center Frequency (Hz): 1G -
Sample rate (Hz): 125M
Decimate Factor: 32
Reference Level (dBm): 0
Data Format: 16bit

<<< Welcome to GNU Radio Companion 3.10.1.1 >>>

Block paths: Imparks ©
The HTRA: 1Q Source module is used to receive |Q data streams from the
HAROGIC spectrum analyzer and process them within GNU Radio. You can
double-click the HTRA: 1Q Source module to open its configuration window,
modify or select the desired parameter values, and then click OK at the bottom
of the window to apply the changes;
Physical Interface: Interface type. Select either USB or Ethernet (ETH) from the

drop-down menu to connect to the device
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Device Number: Set different device numbers when multiple devices are
connected simultaneously

Center Frequency: Center frequency, ranging from 9 kHz to the device's cutoff
frequency

Sample rate: Sampling rate

Decimation Factor: Decimation factor, selectable from the drop-down menu in
the module settings

Reference Level: Reference level, ranging from -50 to +23 dBm

Data Format: Data format used for the acquired 1Q data

Properties: HTRA: IQ Source *x

General Advanced Documentation

Physical Interface USB ~

HTRA: 1Q Source
Physical Interface: USB
Device Number: 0

Center Frequency (Hz): 1G HCenter Frequency (Hz) | 1000000000
Sample rate (Hz): 125M

Device Number 0

Decimate Factor: 32 Sample rate (Hz) 125000000
Reference Level (dBm): 0
Data Format: 16bit Decimate Factor 32 ~

Reference Level (dBm) S0

Data Format 16bit ~

Source - out(0):
Port is not connected.

In the search box, enter QT GUI Frequency Sink and press Enter to add the
spectrum display module. Connect the input of this module to the output of the

HTRA: 1Q Source module to display the IQ signal spectrum in real time;

*untitled - GNU Radio Companion S O &
File Edit View Run Tools Help
= I — -
s -B 70 e AEBDO ¢ » o ou % >
(&) QT GUI Frequency Sink [x]
D Variable
Title: Not titled yet ey ~ Core
(O s HE Value: ;ix ~ Instrumentation
Generate Options: OT GUI :
~ QT
QT GUI Frequency Sink
HTRA: IQ Source
Physical Interface: USB
Device Number: 0 QT GUI Frequency Sink
Center Frequency (Hz): 1G FFT Size: 1024
sample rate (Hz): 125M Center Frequency (Hz): 0
Decimate Factor: 32 Bandwidth (Hz): 32k
Reference Level (dBm): 0
Data Format: 16bit

Click "File" -> "Save" to save the file as Spectrum_display, then click the Run
button at the top of the graphical interface to view the spectrum of the input

signal.
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*getlQ.grc - /fhome/htra/Desktop/gr-htra

File Edit View Run Tools Help

o 7 ﬁ v ¥ 0 7= N u
Core
Options Audio
Title: Not titled yet Variable Boolean Operators

Output Language: Python
Generate Options: QT GUI

ID: samp_rate
Value: 32k

Byte Operators

QT GUI Frequency Sink
FFT Size: 1024

Channelizers
Channel Models

HTRA: I1Q Source Center Frequency (Hz): 0 Coding
Physical Interface: USB Bandwidth (Hz): 32k Control Port
Device Number: 0
Center Frequency (Hz): 1G Debug Tools
Sample rate (Hz): 125M Not titled yet B & & Deprecated
Decimate Factor: 32 . ]
Reference Level (dBm): 0 Digital Television
Data Format: 16bit » Data 0 Equalizers

Error Coding
o File Operators
Filters

Fourier Analysis
GUI'wWidgets
Impairment Models
Industrial 1/O
Instrumentation

1Q Correction

Level Controllers
Math Operators
Measurement Tools

-40

-60

-80

Relative Gain (dB)

-100

-120

-140

T T T
-15.00 -10.00 -5.00 0.00 500 10.00 15.00 Message Tools
Frequency (kHz) Misc

9.7.6 Acquiring 1Q Stream

This example demonstrates how to acquire IQ data and provides the IQ time-domain

waveform, spectrum, and waterfall display.

The following example uses a 1 GHz, -20 dBm single-tone signal to illustrate the

process.

1. Open aterminal in the built gr-htra folder, type gnuradio-companion, and press
Enter to launch the graphical interface;

2. Inthe pop-up graphical interface, click "File" -> "Open" -> "Examples" ->
"IQ_streaming.grc" - > "Open" to load the IQ straming acquisition example from
the routine;

3. Keep the parameters at their default configuration. You can double-click the
corresponding QT GUI Range module and Variable parameter node at the top of
the example to modify the relevant parameters in the HTRA: IQ Source module
(Note: the Decimate Factor must be consistent between the Variable and the
module); Also, double-click the HTRA: 1Q Source module itself to select the

appropriate the interface device and data type.
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Options QT GUI Range QT GUI Range Variable QT GUI Range QT Gl
Title: |Q Streaming 1D: center freq ID: samp _rate ID: decimate_factor 1D: reference_level 1D: center
‘Qutput Language: Python Label: Center_Freguency Label: Sample_rate Value: 64 Label: Reference_Level Label: Ce
Generate Options: 0T GUI Default Value: 1G Default Value: 125M Default Value: -10 Default V
Start: 9k Start: 110M Start: -50 Start: 9k
Stop: 6.3G Stop: 130M Stop: 23 Stop: 6.3(
Step: 100 Step: 1 Step: 1 Step: 100
r 3

Properties: HTRA: IQ Source x

General Advanced Documentation

Physical Interface USB ~

Sample rate (Hz)

Data Format 16bit ~

HTRA: IQ Source
Physical Interface: USB
Device Number: 0

Center Frequency (Hz): 1G

Decimate Factor: &4
e e TEVETTOBT T

Data Format: 16bit

Click the Run button at the top of the GNU Radio Companion graphical interface
to view the time-domain waveform, spectrum, and spectrogram corresponding

to the 1Q stream;

1Q Streaming g @ €
IQvT
u Ch-l
0.02
= = ch-Q
% 0.01
2 o
a
€ -0.01
<
0.02
r T T T T T T T
0 2 a 6 8
Time (us)
Waterfull
2.00e+01
1.50e+01
o
E 1.00e+01
=
5.00e+00
0.00e+00 : : -
999.500 1000.000 1000.500
Frequency (MHz)
Spectrum
0
20
£ %0
5 ]
2 60
-;- ]
80
S
-100
-120 4
140 /i
T T T
999.500 1000.000 1000.500
Frequency (MHz) =
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9.7.7 AM Demodulation

This example is used for AM signal demodulation and demonstrates the time-domain

waveform, spectrum, and demodulated audio waveform of the AM signal.

It

demodulates AM signals with a modulation rate < 15 kHz only. You can design or adjust

the demodulation chain according to your actual requirements.

The following uses the demodulation of a 1 GHz, -20 dBm AM signal with a symbol rate

of 5 kHz and a modulation depth of 50% as an example.

1.

Refer to steps 1 to 2 in the "Acquiring 1Q Stream"

chapter to open the

"AM_demod.grc" example;

The Center Frequency and Reference Level maintain their default configuration.

You can double-click the corresponding QT GUI Range block and adjust the

"Default Value"

frequencies and power levels.

in its properties window to adapt to AM signals of different

Click the Run button at the top of the GNU Radio Companion graphical interface

to view the IQ time-domain plot, spectrum, and demodulated audio waveform of

the AM signal.
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9.7.8 FM Demodulation

This example is used for demodulating FM broadcast signals and demonstrates the
time-domain waveform, spectrum, and demodulated audio waveform of the FM signal.
The following uses the demodulation of a 97.5 MHz broadcast signal as an example.

1. Refer to steps 1 to 2 in the "Acquiring |Q Stream" chapter to open the

"FM_demod.grc" example;

2. The Center maintains its default configuration. You can double-click the QT GUI
Range block corresponding to "center_freq" and adjust the "Default Value" in its
properties window to demodulate FM broadcast signals at different frequencies.

3. Click the Run button at the top of the GNU Radio Companion graphical interface

to view the 1Q waveform, spectrum, and demodulated time-domain waveform of

the FM signal.

FM Demod

PvT
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4096
Blackman
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9.7.9 QPSK Demodulation

This example is used for demodulating QPSK signals and demonstrates the 1Q time-
domain waveform, spectrum, and demodulated constellation diagram of the QPSK
signal, facilitating real-time verification of symbol synchronization, carrier recovery,
and signal quality for users.

The following uses the demodulation of a 1 GHz, -20 dBm QPSK signal with a symbol
rate of 1 MHz and a filter alpha (roll-off factor) of 0.35 as an example.

1. Refer to steps 1-2 in the "Acquiring 1Q Stream" chapter to open the

"QPSK_demod.grc" example;

2. Double-click the Variable parameter nodes corresponding to "decimate_factor"
and "symbol_rate", and modify their respective "Value" in the properties window
to set the Decimate Factor to 16 and the Symbol Rate to 1 MHz. Then, double-
click "HTRA: 1Q Source" and update the value of the Decimate Factor in the pop-
up window. Keep other parameters at their default configuration. You can double-
click other QT GUI Range or Variable nodes to adjust Center, Ref.Level,
SampleRate, Decimate Factor, and Filter Alpha as needed to adapt to different
signals.

Note: SampleRate / Decimate Factor > 4 * Symbol Rate

3. Click the Run button at the top of the GNU Radio Companion graphical interface
to view the time-domain graph, spectrum, and demodulated constellation

diagram corresponding to the 1Q stream;
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9.7.10 QAM Demodulation

This example is used for demodulating QAM16 and QAM®64 signals and demonstrates
the 1Q time-domain waveform, spectrum, and demodulated constellation diagram of
the QAM signal.

The following uses the demodulation of a QAM16 signal with a center frequency of 1

GHz, a reference level of -20 dBm, a symbol rate of 300 kHz, and a filter alpha (roll-off

factor) of 0.35 as an example.

1. Refer to steps 1-2 in the "Acquiring 1Q Stream" chapter to open the
"QAM_demod.grc" example;

2. Double-click the Variable parameter node corresponding to "symbol_rate", and
modify its "Value" in the properties window to set the Symbol Rate to 300 kHz.
Keep other parameters at their default settings. You can double-click other QT
GUI Range or Variable nodes to adjust Center, Reference Level, SampleRate,
Decimate Factor (setting rules refer to the QPSK Demodulation chapter), and

Filter Alpha as needed to adapt to different signals;
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3.

to view the time-domain graph, spectrum, and demodulated constellation
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9.7.11 DAB Demodulation

The DBA demodulation example relies on the open-source project gr-dab. Please

diagram corresponding to the IQ stream.

Click the Run button at the top of the GNU Radio Companion graphical interface

install the gr-dab project according to the following chapter before running it.

Enter the following commands in the terminal sequentially to install gr-dab and its

required dependencies:

sudo apt-get update

sudo apt-get install gnuradio libboost-all-dev libcppunit-dev libfaad-dev

git clone https://github.com/gnuradio/gr-dab.git

cd gr-dab
mkdir build
cd build
cmake ..
make

sudo make install
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sudo ldconfig

9.7.12 WLAN Signal Demodulation

The WLAN demodulation example relies on the open-source projects gr-ieee802-11
and gr-foo. Please install these projects according to the following chapter before
running it.

This example demonstrates the demodulation of an IEEE 802.11a signal at 2.412 GHz,
—20 dBm reference level, 20 MHz symbol rate, and 12 Mb/s rate.

1. Enter the following commands in the terminal, in sequency, to install gr-foo:

git clone https://github.com/bastibl/gr-foo
cd gr-foo

mkdir build

cd build

cmake ..

make

sudo make install

sudo Idconfig
2. Enter the following commands in the terminal, in sequency, to install gr-ieee802-

11:

git clone https://github.com/bastibl/gr-ieee802-11
cd gr-ieee802-11

mkdir build

cd build

cmake ..

make

sudo make install

sudo Idconfig
sudo sysctl -w kernel.shmmax=2147483648

3. Refer to steps 1 to 2 in the chapter "Acquiring 1Q Stream" to open the

"WLAN_demod.grc" example;
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Click the Run button at the top of the GNU Radio Companion graphical interface.
Set the "freq" parameter in the result display window to 1|2412.0|11g to view
the corresponding time-domain graph, spectrum, and demodulated constellation

diagram of the 1Q stream.
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9.8 Java (to be supplemented)

It is important to note that when writing programs in Java to control devices on a Linux
system, the CalFile folder needs to be placed in the same directory as the Java

interpreter.
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